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Introduction

The following topics are covered in this chapter:

O Overview
O System Requirements

0 Specifications



MX-AOPC UA Logger Introduction

Overview

With most remote data acquisition systems, during daily operations additional human resources are needed to
collect data manually from remote storage devices for loading into a database. Even with remote 1/0 devices
remotely collecting data over a network, software must be developed to handle the task of converting and
uploading data logs. Moxa’s MX-AOPC UA Logger not only makes real-time data collection much easier, it also
simplifies the conversion of historical data into database-ready formats. Moxa’s MX-AOPC UA Logger interacts
directly with our MX-AOPC UA Server, working as a bridge between field data and cloud storage, as well as
stored databases or spreadsheets. The MX-AOPC UA Logger can collate tags from individual Moxa remote 1/0
devices into the same cloud, database, or spreadsheet, freeing users from the need to manipulate data after
processing.

One of the benefits of using remote 1/0 devices is that data can be collected over a network from a central site.
In an ideal operation, after a network failure remote 1/0 devices should be able to transmit data logs that were
collected while the network was offline. Moxa’s MX-AOPC UA Logger makes this not only possible, but easy.
MX-AOPC UA Loggers provide a standard OPC interface that interacts with MX-AOPC UA Servers for real-time
data collection. After each network connection, an MX-AOPC UA Logger will compare historical data stored on
the microSD cards located in individual ioLogik 2500 devices with the real time data it has already stored locally,
and then supplement any missing data by requesting that the ioLogik 2500 retransmit the lost data.
Furthermore, MX-AOPC UA Logger also supports functions for providing data on schedule and on demand. It
will automatically retrieve the lost data when the on-schedule or on-demand function is triggered.

The MX-AOPC UA Logger includes:

= Logger Runtime Service: Starts as a service by default after installation.

= Configuration Console: A configuration tool for configuring settings.

System Requirements

Hardware Requirements

CPU: Intel Pentium 4 or above

RAM: 512 MB (1024 MB recommended)
Communication Interface: Ethernet

Software Requirements

Operating System: Microsoft Windows 7/8/10, Microsoft Windows Server 2003/2008/2012
Microsoft .NET Framework: v3.5 Service Pack 1

Editor (optional): Microsoft Office 2003 (Access or Excel) or later

Database (optional): Oracle database (x86), Microsoft SQL Server (x86), MySQL (x86)
Cloud (optional): Microsoft Azure
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Specifications

OPC Specifications
OPC Unified Architecture: 1.02

Products that Support Data Supplement Auto Mode, on Schedule, and on Demand
Model Names: ioLogik 2500 series
Note: Please check Moxa’s website for the most up-to-date list of supported products.

Fully Supported OPC UA Client Profiles
e Core Client Facet

e User Token: User Name Password Client Facet
« User Token: X509 Certificate Client Facet

e Security Policy: Basic128Rsal5

e Security Policy: None

« Data Access Client Facet

e UA-TCP UA-SC UA Binary

- Attribute Write Client Facet

e Data Change Subscriber Client Facet

1-3



2

Getting Started

The following topics are covered in this chapter:

a

a
m)
a
a

Qaoaoaogaoaa

Designing the System Architecture

Installing the MX-AOPC UA Logger

Opening the Configuration Console

Configuring the MX-AOPC UA Logger Settings
Connecting to the MX-AOPC UA Server

» Getting the Server Endpoint from the MX-AOPC UA Server
» Connecting to MX-AOPC UA Servers

Creating Loggers

Starting Runtime Service

Starting Recording

Testing the Data Supplement Function

Testing the Data Supplement on Demand Function

Testing the Data Supplement on Schedule Function



MX-AOPC UA Logger Getting Started

Designing the System Architecture

The MX-AOPC UA Logger provides two main functions.

= Storing real-time data collected through an MX-AOPC UA Server from individual 1/0 devices to a database
or spreadsheet.

= Retrieving buffered data stored on a microSD card located in a Moxa device that supports data buffering,
such as the Moxa ioLogik 2500 series, and then supplementing the database or spreadsheet with missing
data.

We recommend using one of the following two scenarios when designing the system architecture:

Scenario 1: Write real-time data to a database, spreadsheet, or Azure Cloud

= MX-AOPC UA Logger saves data from selected OPC tags to a database, spreadsheet, or Azure Cloud. The
data comes from MX-AOPC UA Server only, which collects data from field devices.

= MX-AOPC UA Server, MX-AOPC UA Logger, and Database can be installed either on the same computer or
on different computers. We strongly recommend installing MX-AOPC UA Logger and Database on the same
computer.

|
-
=l
Erim ) == Microsoft Azure
QPC DA
IoT Hub _,
MX-AOPC UA Server MX-AOPC UA Logger Database
- - P
& > H < S
Static IP OFC UA oDBC
' EEn ¥<d A d
e £ =
£ oy v 1P
Moxa AOPC L
Modbus OoORACLE b4}
DATABASE MySOL:
Static IP
’-_Hﬁ
LHJ
Remote I/0

Scenario 2: Collect real-time data while the network is up and running, and

retrieve buffered data stored in Moxa devices when the network is

disconnected

= Refer to Scenario 1 for real-time data collection.

= When network communication is reestablished, the MX-AOPC UA Logger automatically retrieves buffered
data saved on microSD cards installed in Moxa’s devices when the network was disconnected.

= After retrieving data from the data logs, the MX-AOPC UA Logger automatically saves the data to the
database or spreadsheet.

= The MX-AOPC UA Logger supplements data only for OPC tags, which are selected both in the AOPC function
of the Moxa device with the 10xpress utility (AOPC -> Tag Selection), and in the Logger settings of the
MX-AOPC UA Logger with its configuration console.

* For this scenario, microSD cards must be installed in your Moxa devices.

= The MX-AOPC UA Logger’s data supplement function must be enabled (the default), which can be done with
the configuration console under Tools - Data Supplement Settings.



MX-AOPC UA Logger Getting Started

If the IP address of the Moxa cellular device is private or dynamic, Cellular Data Access software must be
used to enable the MX-AOPC UA Logger to access Moxa cellular devices. We recommend installing the
Cellular Data Access software and MX-AOPC UA Server on the same computer. Use Moxa’s 10xpress utility
to enable the Cellular Data Access function on the Moxa cellular device at Network - Cellular - Cellular
Data Access. Use the MX-AOPC UA Logger’s configuration console at Tools - Data Supplement

Settings.

When the Moxa cellular device uses a static IP

OPC UA
OPC DA
MX-AOPC UA Server MX-AOPC UA Logger Database
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The following software can be downloaded from Moxa’s website at www.moxa.com:

= MX-AOPC UA Logger v2.0 or later
= MX-AOPC UA Server v2.0 or later
* Cellular Data Access v1.2 or later
= 1Oxpress utility v2.1 or later
= Moxa device firmware that supports the data supplement function:
» ioLogik 2500 series
- ioLogik 2500-Ethernet v2.2 or later
. ioLogik 2500-HSPA v2.2 or later
- ioLogik 2500-WL1 v2.2 or later

Refer to the MX-AOPC UA Server User’s Manual for instructions on how to install and configure Moxa’s MX-AOPC
UA Server software.

Refer to your Moxa device’s user’s manual for instructions on installing 10xpress and Cellular Data Access on a
computer, and for updating your Moxa device’s firmware.

Installing the MX-AOPC UA Logger

The MX-AOPC UA Logger can be downloaded from Moxa’s website at www.moxa.com.

After downloading the file, unzip it and run setup.exe. The installation program will guide you through the
MX-AOPC UA Logger installation process.

NOTE Microsoft .NET Framework v3.5 Service Pack 1 is required before installing MX-AOPC UA Logger. After the .NET
Framework is installed, restart your computer and run setup.exe again to install MX-AOPC UA Logger.

Opening the Configuration Console

Open the MX-AOPC UA Logger’s configuration console from the Windows Start menu: Start > All Programs
2> MOXA - 10 Server > MX-AOPC UA Suite > MX-AOPC UA Logger.

Select the appropriate main network adapter the first time you open the configuration console.

Select Main Metwork Adapter e S

Main Metwork Adapter: |InteI{R} Ethernet Connection {3) I2181M - |

Mote: The main network adapter needs to be enabled for starting runtime service,
This setting cannot be modified after this configuration.

oK ] | Cancel
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MX-AOPC UA Logger Getting Started

The configuration console is an configuration tool for configuring Logger Runtime settings. When the
configuration console is launched, it will automatically get the latest configurations from the Logger Runtime.

ﬁ MX-AOPC UA Logg

File Server Logger Tools Runtime Help

TEREBBNERG 0088 8S

o ﬁ Server Group

&4 Logger Group List

Date Time: Event

4 T +

Service Status: Stopped Time: 08:21:05 Data Supplement Queue: 0000

Configuring the MX-AOPC UA Logger Settings

The MX-AOPC UA Logger settings described below can be configured under the Tools menu.

£ Mx0vc UA Logge T

File Server Logger | Tools | Runtime Help
Data Supplement Settings | ﬁ‘

LHN B

------- ﬁ Server Group

Certificate Management

System Log L
Change Password

Opticns

[ B Logger Group List

= Change Password

We strongly recommend changing the password the first time you use the Configuration Console. The
default password is moxa, which is needed for verification when exporting the system log to a text file.
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Data Supplement Settings

Select the Data supplement after network reconnection checkbox if the Moxa product supporting the
data supplement function is connected to an MX-AOPC UA Server.

Select the Data supplement on schedule checkbox if the Moxa product supporting the data supplement
on schedule function is connected to an MX-AOPC UA Server.

Select the Data Supplement through Cellular Data Access checkbox if the IP address of the Moxa
cellular device is private or dynamic.

General Settings

Retry Timeout 30 sec(s) (5 to 600, default: 300

Retries 3 {0 to 10, default: 3)

Triggering Event

Data supplement after network reconnection
[ | pata supplement on schedule

Everyday at 00:00

Data loss in the past | 1 day(s) (1 to 7, default: 1)

[] Data supplement through Cellular Data Access

IP Address c .0 .0 .0

Port |9400 {0 to 65535, default: 9400)
Folder for supplementary data

Path C:\Users\Public\Documents\Maxa MYACPCL E]

Log Folder for Data Supplement on Demand

C:‘l.l_Jsers\FuEiic\DnmmentsananDPCLI

[ oK J [ Cancel
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Certificate Management

If the security policy of the MX-AOPC UA Server is set to Basic128Rsal5: Sign, Basic128Rsal5: Sign
and Encrypt, or both, importing an OPC UA client’'s CA (Certificate Authority) file into the MX-AOPC UA
Server, and exporting the MX-AOPC UA Server’s CA file to OPC UA Clients are both required.

Click the Trust Servers tab, click Import, and select the server’s CA file to import it into the MX-AOPC UA

Logger.

Trust Servers | Instance Cerﬁﬁmtes|

Server Mame

i MX-AQPC LA Server

URI
urn:CHARLESCHEM-ME:MX-AQPC UA Server

1L

[ Import... ] i Export... i |

Remove

i | Trust | i'u'iew Certificate. .. |

Close
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Select the Instance Certificates tab and click on Export Logger Certificate to export the MX-AOPC UA
Logger’s CA file to the OPC UA Server.

Cenihcates Menogerer -
Trust Servers | Instance Certificates |

[ View Logger Certificate... ] Certificate MX-AQOPC LUA Logger is from
1/9,/2018 4:74:45 PM to 12/14/2022
4:24:45 PM

[ Export Logger Certificate... ]

[ Reizsue Certificate ]

NOTE After reissuing certificates or re-installing the MX-AOPC UA Logger, you will need to export the Logger
Certificate to the OPC UA Server again.

2-8
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Connecting to the MX-AOPC UA Server

Getting the Server Endpoint from the MX-AOPC UA Server

Open the MX-AOPC UA Server configuration console and select Tools - OPC UA Settings > Server
Endpoint Settings to go to the MX-AOPC UA Server configuration console to copy the MX-AOPC UA Server’s
Server Endpoint.

Ensure that the status of the Server Endpoint is Valid.

Server Endpoints S_ X

URL Status
opc. top: /192, 168, 127, 200: 53192 MXAQPC JUAServer Valid

Metwork Interface: |Intel(R) Ethernet Connection (3) 12184M -

Port Mumber: 53192

opc.top: 192, 168, 127, 200: 53192 MXAQPC UAServer

| add || oDelete || Apply | | close |

Connecting to MX-AOPC UA Servers

1. Click the Server Group and then click the Discovery icon to start discovering MX-AOPC UA Servers.

£ Mi-A0PC UA Logo

Eile 5Server Logger Tools Runtime Help

ERSEHRG 008

- . ———

----- ﬁ Server Group

pa—

------ & Logger Group List

2-9
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2. Select the Local Server option if MX-AOPC UA Server and MX-AOPC UA Logger are installed on the same
computer. Otherwise, select the Remote Server Endpoint option and paste in the Server Endpoint from
the previous step. Type in the MX-AOPC UA Server’s password and then click Next.

orcoysers ===

() Local Server

| w

@ Remote Server Endpoint

opc. top: ff192. 168, 127, 200: 53192 MXACPC JUAServer

Password bbb

<gack || MNext> | | cCancel

2-10
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3. Modify Server Name, and configure Security Policy and Security Mode, which should be the same as
the MX-AOPC UA Server’s UA Settings. If necessary, change the Publish Interval, Sampling Interval,
Queue Size settings, and select or deselect the Discard Oldest settings checkbox, and then click Finish.

orcrysers ==

Server Name  Serverd| (max. length = 30; "." is not allowed)

Server Endpoint:  opc.top: /192, 168, 127, 200: 53192 MK AOPC UAServer

Security Policy [NDI"IE hd ]

Security Mode [NOHE hd ]

Subscription Settings

Publish Interval 1000 % ms {0 to 85400000, default: 1000)

—

Keep Alive Count i_IIII_
1 ]
Lifetime Count i 1000 .

Maonitored Item Settings
sampling Interval 500 '—E—" me (-1 to 86400000, default: 500)
=

[

Queue Size 10 (0 to 10000, default: 10)

—
4

Discard Oldest

<Back | Fiish | | cancel

4. Select the server and click the Connect icon to connect to the MX-AOPC UA Server.

i{mx-nopc UA Logger

File Server Logger Tools Runtime Help

TR BERDNSRG0088 88

=5 ‘ Server Group
‘ Server1(192. 168, 177.200:53192)

Server Endpoint: opc.tep:[f192. 168.127. 200:53192/MXAOPCUAServer

Security Policy: ~ None

Security Mode: MNone

=~ &4 Logger Group List

&3 LoggerGroupl Subscription Settings Monitored Item Settings
Publish Interval: 1000 ms Sampling Interval: 500 ms
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes

2-11
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5. Once the server is connected, you will not be allowed to change the server connection settings. To change
the server connection settings, click the Disconnect icon to disconnect the MX-AOPC UA Server, and then
click the Properties icon to change the server connection settings.

a0 e R = =i )
File Server Logger Iools Runtime Help
IEAEBENSRGT0088 88 -

B w Server Group i
B )5erver1(192.168.127.200:53192)

Server Endpoint: opc.tcp: f/192, 168, 127, 200:53192MXAOPC fUAServer
Security Policy: None

Security Mode:  None

=~ &4 Logger Group List

@ LoggerGroupl Subscription Settings Monitored [tem Settings
Publish Interval: 1000 ms Sampling Interval: 500 ms
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes
3 1 R
CLETE e - S e e

File Server Logger Tools Runtime Help

DERBEBRNSRIG 008888

=5 U Server Group

Server1(192.168.127.200:53192) Server Endpoint:  opc.tep: /192, 168, 127, 200:53192/MXAOPC/UAServer

Security Policy: ~ None

Security Mode:  None

=~ &4 Logger Group List

&3 LoggerGroupl Subscription Settings Monitored Item Settings
Publish Interval: 1000 ms Sampling Interval: 500 ms
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes

NOTE

Ensure that the server connection is in connecting status before starting to record data to a database or
spreadsheet.
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MX-AOPC UA Logger

Creating Loggers

1. To create a data Logger, click Logger Group List, click the New Logger Group icon, and then type in the

name of the logger group.

B MX-A0PC UA p

-,ﬁ Lugger 93 - 9 -
Eile  5erver Logger Tools Runtime Help
o o = e = = =" . :
TFEAPBPEBEEK T 008 &

= n Server Group

-£8 Logger Group List

B

Logger Group Mame LoggerGroupl
{max. length = 30; "."is not allowed)

ok | | cancel |

2. Click the logger group, and then click the New Logger icon to create a logger.

2-13
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3. Type in the name of the logger, select Excel File, Access File, Database, or Azure 10T, and then modify
the root path. Set the source name of the database, or type in the Connection String. Click Next to
continue.

H MCAGPC UALoggerT THIR TR SRR SIS F Th SEREREsS. & Tupe = The TERREERe- T—
Fi

le Server Logger Tools Runtime Help

rerpeenlBRrRa 008888

= - Server Group Logger Name Type Output
------- I server1(192.168,127.200:5319

s L =

Logger Mame

(max. length = 30; only 20if using Orade Database)

(@) Excel File:
Root Path: C:\Users'\Public\Documents Moxa \MXACPCLogger \Logger E

File separated every min. {default: 60)

() Access File:

Root Path: |C:'|J_lsers\Public\.DocumentsWoanXAOPCLDgger\Logger | | J

() Database:

Source Name: | Setting J

() Azure IoT:

Date Time Connection String:

2018/01/24 08:49:15

<gack || mext> | [ cancel

4. If necessary, modify the name and order of Table Fields. Add <DATA_TYPE>, <SERVER_UTC_TIMESTAMP>,
etc., if they are required to be recorded into the database or spreadsheet, and then click Finish.

oo e A ==

Data Field *Table Field Data Type ~ || i
<UINIT = <UNIT = String E
=SOURCE_UTC_TIMESTA... <SOURCE_UTC_TIMESTA... **String

<SOURCE_TIMEZOME = <SOURCE_TIMEZOME = Float

<DATA_TYPE=

<SERVER_UTC_TIMESTA...
<SERVER_TIMEZOME >
<QUALITY >

OOoOE

*max, length =30; = * [ 1" are not allowed.
** option: DateTime or String

Automatically start recording when service starts running.

<o | ] [conn

2-14
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5. Click the Refresh button to get the latest MX-AOPC UA Server OPC tags.

Server Logger Toels Runtime Help

TERBEBNERI0COSSSS

=] - Server Group
‘ Server1(192.168.127.200:53192)

Recording
L sat || swp |

Automatically start recording when service starts running

Tag Selection
=~ Logger Group List [Senrerl VI [&II Device V]@
E‘ﬁ ;ggerGroupl Available Tags d Tags
k Logger1|
Tag Name E] Tag Name
Server Name  Tag Name Description

Property
Type: Excel
Output:  C:\Users\Public\DocumentsMoxa MXAOPCLogger\Logger\Logger 120180124 005331 E]

Table: Loggeri
Data Field Table Field Data Type Order
<TAG_ID> <TAG_ID> String i
<VALUE=> <VALUE=> String 2
<UNIT> <UNIT> String 3
<50URCE_UTC_TIMESTAMP > <SOURCE_UTC_TIMESTAMP> DateTime 4
<50URCE_TIMEZONE > <50URCE_TIMEZONE > Float 5

6. Click the appropriate arrow buttons to add items to or remove items from the Selected Tags list.

m

File Server Logger Tools Runtime Help

TERBEBRNESRFI0COSESS

=

Server Group
s Server1(192.168.127.200:53192)

Recording

| st || swp |

Automatically start recording when service starts running

Tag Selection
-8 Logger Group List ISenrerl = I Al Deyice '] @
=88 L°§QEVG’°U91 Available Tags lected Tags
Logger1
9 Tag Mame i E] Tag Name

‘3!}“DewoeGroup1.Dewoel.TagGroupl.TaD E] iy 2542-01,A1-00

5 E2242-01.A1-00 E] W 2542-01.A1-01

P E2242-01.A101 i 2542-01.A1-02

P E2242-01.A1-02 - E W 2542-01.A1-03

q i b i 2542-01,010-00 -
Server Name  Tag Name Description =
Serveri Y 2542-01.A1-00 Desc o
Serveri Wy 2542-0LAI-01 Desc

Serveri W 2542-01.A1-02 Desc

Serveri W 2542-01L.A1-03 Desc -
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Starting Runtime Service

After connecting the MX-AOPC UA Server and creating the Logger, click the Start Runtime Service icon to
start running the MX-AOPC UA Logger service.

4 MX-AOPC UA Logger

File Server Logger Tools Runtime Help

rereERNnERaCloss s s

= ' Server Group -

| Recording —
E 5 Server1{192, 168.127.200:53192) — ——
[ st || swp |
[ Automatically start recording when service starts running
Tag Selection
- Logger Group List [Servarl -] | @i Gevics -] @
e LoggerGroup1 Available Tags Selected Tags
5 9 Logger1
Tag Name 5 » Tag Name o
% DeviceGroup 1. Device 1. TagGroup 1.TaD E] W 2542-01.A1-00 @
Sy E2242-01.A1-00 E i 2542-01.A1-01
Wy E2242-01.A1-01 i 2542-01.A1-02
W E2242-01.A1-02 - E i 2542-01.A1-03
4 ] r ¥ 2542-01.010-00 -
Server Name  Tag Name Description ko
Server1 Uy 2542-01.A1-00 Desc ]
Serveri W 2542-01.A1-01 Desc 3
Server1 W 2542-01.A1-02 Desc
Server1 W 2542-01.A1-03 Desc -

A green light next to the logger name indicates that the logger is ready to record.

| 54 MX-AOPC UA Logger

‘| Eile Server Logger Tools Runtime Help
IFEAEEBROER T C 1888 |
CTFRAEEBENERG 004 | ﬁ
& Server Group Recording e
= 5 Serveri{192,168.127.200:53192) _
=
["] Automatically start recording when service starts running
Tag Selection
= H Logger Group List | v| | -| lC‘
B lmiietpl Available Tags Selected Tags
Tag Name | | Tag Name
L |
L <]
[ «]
Server Name  Tag Name Description =
Serverl Y 2542-01.A1-00 Desc [
Serverl Y 2542-01.A1-01 Desc 3
Serverl %Y 2542-01.A1-02 Desc
Serverl Y 2542-01.A1-03 Desc -
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A yellow light next to the logger name indicates that the logger setting is not correct. Check the settings of the
logger, and then confirm the database or spreadsheet settings again.

MX-AQPC UA Logger

File Server Logger Tools Runtime Help
A o e — o - Ei - _— - : —
CTEEHEBEEBROY QO& &
il =- ﬁ Server Group EETeion f=
ﬁ Server1(192. 168,127,200:53192)
Start Stop
I Automatically start recording when service starts running I
Tag Selection
=] H Logger Group List | | C
=g Available Tags Selected Tags
Tag Name » Tag Mame
»
4
«
Server Name  Tag Name Description

You will not be allowed to modify the server connection and logger settings when runtime service is running. To
stop runtime service, click the Stop Runtime Service icon.

(=T NS WL e

File Server Logger Tools Runtime Help i
a— : e — — — = .
TEHREBEEBROEK T Of d88
il = ﬁ Server Group R =
@ Server1(192. 165.127.200:53192)
Automatically start recording when service starts running
Tag Selection
= §:f Logger Group List - ]
E-#5 LoggerGroupl Available Tags Selected Tags
Q Logger1
Tag Name . Tag Name
>
4
«
Server Mame  Tag Name Description =
Serverl ¥ 254201 A1-00 Desc E
Serverl ¥ 2542-00A1-01 Desc 3
Serverl ¥y 2542-01A1-02 Desc
Serverl ¥ 2542-01A1-03 Desc -

NOTE Configuration changes will be updated to Logger’s runtime service after the runtime service is started. If the
runtime service is not started, any change will be discarded when the configuration console is closed. Be sure
to save your project file when you close the configuration console.

NOTE Stopping Runtime Service will stop both the logger recording and data supplement functions, which may cause
data loss.
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Starting Recording

To start recording data, click the logger icon and then click the Start Recording icon to start recording the

selected tags into the database or spreadsheet.

&4 MX-AOPC UA Logger

File Server Logger Tools Runtime Help B -
L8 ﬂﬁﬁﬂﬁﬁ@@@ & &
= ' Server Group =
' Server1(192. 168.127.200:53192)
. [ stop |
[ automatically start recording when service starts running
Tag Selection I
=~ B Loggar Group List - | " | " E‘
ol Available Tags Selected Tags
Tag Name | » | Tag Name
>
ED
[(«]
Server Mame  Tag Mame Description o
Serverl W 2542-0LA1-00 Desc o
Serverl W 2542-0LA1-01 Desc 3
Serverl W 2542-0LA1-02 Desc
Serverl W 2542-0LA1-03 Desc -

A red light next to the logger indicates that the logger is recording.

File Server Logger Tools Runtime Help

TEABEBAESKG00SESS |

-
- ' Server Group Remrd\ng B
‘ Server1{192, 168.127.200:53192)
| [
—|Aubomaﬁcal\y start recording when service starts running
Tag Selection
= B Logger Group List | - | | - | E‘
i A Available Tags Selected Tags
Tag Name | » | Tag Mame
»
KR
[«]
Server Name  Tag Name Description ko
Serverl Y 2542-01.A1-00 Desc o
Serverl W 2542-01.A1-01 Desc F
Serverl Y 2542-01.A1-02 Desc
Serverl Y 2542-01.A1-03 Desc -
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Click the folder icon to check if data is being recorded into the target spreadsheet.

fZemres oo . oo

File Server Logger Tools Runtime Help

TER BEEBRNEKRG0C0SHESS

= v Server Group

[ Server1(192. 168.127.200:53192)

Recording
Start Stop

Automatically start recording wher

=~ i Logger Group List
El-#&5 LoggerGroupl
B 0 Loggerl

»

n service starts running

Type: Excel

Table: Loggeri

Tag Selection
C
Available Tags Selected Tags
Tag Name et Tag Mame
>
4
-«
Server Name  Tag Name Description a5
Serverl F 2542-01.AI-00 Desc U |
Serverl " 2542-01.AI-01 Desc 3
Serverl F 2542-01.A1-02 Desc
Serverl § 2542-01AI-03 Desc -
Property

Cutput:  C:\Users\Public\Documents\Moxa WMXACPCLoggerLogger\Loggerl_20180124 005331 I

NOTE Be sure to close the target spreadsheet listed in the target root path before starting to record. If the target
spreadsheet is open, the MX-AOPC UA Logger will not be able to record data to the target file.

NOTE DO NOT open the spreadsheet while recording is under way. Doing so will cause the spreadsheet file to become

corrupted because it is in use by the MX-AOPC UA Logger service. To open the spreadsheet, stop the MX-AOPC

UA Logger’s runtime service and then click the folder icon to access the file.

Testing the Data Supplement Function

Take the following steps to test the data supplement function.

1.

Insert a microSD card into your Moxa device.

2. Use IOxpress to configure the Moxa device to allocate data buffer size for network failure and to enable
connection to the MX-AOPC UA Server.

Settings |

Click&Go Plus Click&Go Plus Simulator

=i System
= Security
= Network
=10
= £ ACPC
=i Tag Selection |
= SNMP
= Modbus/TCP Slave
= Modbus/TCF Master
= Serial Port
= Data Logging
= Profile
EFTR
(= Click&Go Plus

OE®

Enable connection to AOPC Server with heartbeat interval

30 sec(s)

Server Mode

@ Single Server

() Dual Servers

1st AQPC Server 192 . 168 . 127 . 200

Port 9900

) Failover

[

[

Mote:

1. The network failure data buffer can store up to 20,000,000 records. You can enable this function on the "Data Logging = Profile”™

page.

2, The shortest interval for recording tags in the data buffer is 5 seconds.




MX-AOPC UA Logger Getting Started

s [ asacons | owcorssmiew | rerorer [

= System Required external memory size: 2 GB (support microSD up to 32 GE)
= Security
= Metwork
=1Lo Timestamp column: @) Device local time (7) UTC and time zone

E = AORC
| Server Connection Mo, Profile Mame  Storage Max. Records  Records per File

[zl

I. Enable data buffer for network failures (requires 2 GB of memory) I

= Tag Selection
£ SNMP
= Modbus/TCP Slave
= Modbus/TCP Master
= Serial Port
= = Data Logging

= Profile
= FTP Profile Settings
[ & Click&Go Pl 7
[ = Click&Go Plus Naic [] Enable at Power On
Maximum -SELZ % 10,000 records Records :I: i % 1,000 records (1 to 65; default: 1)

{Mote: Maximum records must be at least double the Records per

3. Select the checkboxes of the tags associated with the data you would like the MX-AOPC UA Server to

update.
Settings Click&Ga Plus | Click&Go Plus Simulator | Peer-to-Peer _
= System
Zoie Select Module [al v| [ selectal || unselectal || applytoal |
=
= Network
210 1/O Type [AI
B = ACPC Slot Mo. Channel No. Description On Change
= Server Connection s -
& Tag Selection [Slot 00 Model: 2547] 0 Desc Disabled
SNMP [Slot 00 Model: 2543] 1 Desc Disabled
=
= Modbus/TCP Slave [Slot 00 2 2 Desc Disabled
= Modbus/TCP Master [Slot O x| 3 Desc Disabled
= Serial Port

4. If the cellular device’'s SIM card uses a private or dynamic IP address, enable the Cellular Data Access
function. If the SIM card is using a public IP address, continue with step 5.

.
£ System ) )
5 General VPN Reconnection Port Forwarding DDNS Cellular Data Access
= Security
Bl & Network
£ General r Enable Cellular Data Access_l
=i LAN
s P Address 12 188 . 12 . 11
=10
SHMP
5 Modbus Port 3401
=
=1 ADPC <
= Serial Port Unigue ID 0
= Data Logging ]
= Click&Go Plus Heartbeat 30

5. Update the device’s configuration.

i Moxa I0xpress - CAUsersiPublic\Documents\Moxa\i0xpress\Da

Project Device Configuration Options Help

Y — o —— g;‘l i é\

al IR HES™ Y=L |

e e |
=32542-01 - 192.168.127.253

[Update Configuration to Device ']

Overwrite Network Setting

[a -
[Tl No. Device Name Model Mame  (Cellular) IP Address CDA IP Address MAC Address Configuration
D a 2542-01 2542 19 253 0 254201
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6. Conduct Set Device Date & Time on the device to ensure that the device, MX-AOPC UA Server, and
MX-AOPC UA Logger are time synchronized.

Iy Moxa IOxpress - C\Users\Public\Documents\Moxa\lOxpress\Databa
Project Device Configuration Options  Help

el @ = - \i - ?
DEHE Y8l
[z =aDevice Library Deplayment
=32542-01- 192.168.127.253
[set Device Date &Time -
@ Sync with PC () Manual Setting Date; mis;‘ '1..-‘2-1 : Time: [12:30:28 = furc)
[an -] Apply t Al
[T No. Device Name Madel Name (Cellulzr) IP Address CDA IP Address MAC Address
E o 2542-01 2542 192,168.127.253 00-90-E58-5A-21-6E

7. If Cellular Data Access software is required, enable the MX-AOPC UA Logger’s Data supplement through
Cellular Data Access option at Tools - Data Supplement Settings. If Cellular Data Access software is
not required, continue with step 8.

General Settings

Retry Tmeout 30 sec(s) (5 to 600, default: 30)
|
Retries 3 {0 to 10, default: 3)
Triggering Event

Data supplement after network recannection
[ Data supplement on echedule

Everyday at 00:00

Data loss in the past | 1 . day(s) (1 to 7, default: 1)

1 Data supplement through Cellular Data Access

IP Address g -0 & .0

Port 9400 {0 to 65535, default: 9400)

Folder for supplementary data
Path C:-‘i.UsErs.‘i.i:-‘ui:;ii.l:-:-‘bomments.ﬁdoxaiﬂmﬂlﬂCLI- E]
Log Folder for Data Supplement on Demand

C:-‘i.UsErs.‘i.i:-‘ui:;ii.l:-:-‘bomments.ﬁdoxaiﬂmﬂlﬂCLI-

| ok || cancl
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8. Ensure that the logger is in recording mode.

Server Logger Tools Runtime Help
_— emm = | mE mE B E] - . - - -
a4l R , . _ .
Server Group e =
[ Server1(192.168.127.200:53192) - i
Start I
Automatically start recording when service starts running
Tag Selection
=1~ &4 Logger Group List | | C|
= Gl 1 Available Tags Selected Tags
Tag Name | | | TagName
=20
“
Server Mame  Tag Name Description o
Serverl T 2542-01.A1-00 Desc o
Serverl T 2542-01.A1-01 Desc 3
Serverl W 2542-01.A1-02 Desc
Serverl ¥ 2542-01.A1-03 Desc -

9. Disconnect the Ethernet connection between the Moxa device and the MX-AOPC UA Server. Wait longer
than the heartbeat interval (the ioLogik 2500’s default heartbeat interval is 30 sec.) plus the heartbeat
tolerance (the MX-AOPC UA Server’s default heartbeat tolerance is 30 sec.), and then check if the tag status
is “Disconnected” on the MX-AOPC UA Viewer. If it is disconnected, wait longer than the update interval of
the tags, and then reconnect the connection between the Moxa device and MX-AOPC UA Server.

TS v O S =

File Tools Help

b Active Device List Tag Name Description Data Type Device timestamp (UTC) Time Zone  UTC+T.Z. Access Rights|  Quality Update Count.
V@ 2542-01.A1-00 Desc Float 05:54:08.000 2018/01/24 utc+8 13:54:08.000 2018/01/24 Read-only Disconnected
S T 2542-01.A1-01 Desc Fioat 05:54:08.000 2018/04/24  UTC+8  13:54.08.000 2013/01/24  Read-only Disconnected
B ;. DeviceGroup1 ‘@ZS‘IZ—OLM-(]Z Desc Float . 05:54:08,000 2018/01/24 utc+8 13:54:08.000 2018/01/24 Read-only Disconnected
& Devicel i 2542-01.A1-03 Desc Float i 05:54:08.000 2018/01/24  UTC+8  13:54:08.000 2018/01/24  Read-only Disconnected
= TagGroupl “ 2542-01.010-00 Desc Boolean 0 05:51:08.000 2018/01/24  UTC+8 13:51:08.000 2018/01/24  Read-only Disconnected
25420101001 Desc Boolean 05:51:08.000 2018/01/24  UTC+8  13:51:08.000 2018/01/24  Read-only Disconnected
‘@ 2542-01.D10-02 Desc Boolean 05:51:08.000 2018/01/24 utc+8 13:51:08.000 2018/01/24 Read-only Disconnected
25420101003 Desc Boolean 05:51:08.000 2018/01/24  UTC+8  13:51:08.000 2018/01/24  Read-only Disconnected
V@ 2542-01.D10-04 Desc Boolean 05:51:08.000 2018/01/24 utc+8 13:51:08.000 2018/01/24 Read-only Disconnected
25420101005 Desc Boolean 05:51:08.000 2018/01/24  UTC+8  13:51:08.000 2018/01/24  Read-only Disconnected
‘@ 2542-01.D10-06 Desc Boolean 05:51:08,000 2018/01/24 utc+8 13:51:08.000 2018/01/24 Read-only Disconnected
925420101007 Desc Boolean 05:51:08.000 2018/01/24  UTC+8  13:51:08.000 2018/01/24  Read-only Disconnected
‘@ 2542-01.D10-08 Desc Boolean 05:51:08.000 2018/01/24 utc+8 13:51:08.000 2018/01/24 Read-only Disconnected
iy 2542-01D10-09  Desc Boalean 05:51:08.000 2018/01/24  UTC+3  13:51:08.000 2018/01/24  Read-only Disconnected
‘@ 2542-01.D10-10 Desc Boolean 05:51:08.000 2018/01/24 utc+8 13:51:08.000 2018/01/24 Read-only Disconnected
¥ 2542-01DI0-11  Desc Boolean 05:51:08.000 2018/01/24  UTC+3  13:51:08.000 2018/01/24  Read-only Disconnected
% 2542-01.5ysConn... System Con...  Boolean 05:54:58.818 2018/01/24  UTC+48 13:54:58.818 2018/01/24  Read-only Good
¥ 2542-01.5ysIPAd... DeviceIP Ad... String .16, 05:54:53.8182018/01/24  UTC+8  13:54:58.818 20180124  Read-only Disconnected
Y 2542-01.5ysMAC Device MAC ...  String : .. D5:54:58.818 2018/01/24  UTC+8 13:54:58.818 2018/01/24  Read-only Disconnected

Date Event

2018/01/24 13:56:20 The tag DevicaGroup 1. Device 1. TagGroup 1.Tag 1 changes the quality from Bad to Disconnected

2018/01/24 13:54:50 The tag 2542-01.5ysConnect-00 changes the value from 1 to 0 )
2018/01/24 13:54:59 The tag 2542-0 1.5ysIPAddress changes the quality from Good to Disconnected 3
2018/01/24 13:54:50 The tag 2542-01.5ysMAC changes the quality from Good to Disconnected

2018/01/24 13:54:59 The tag 2542-0 1, AI-03 changes the quality from Good to Disconnectzd

2018/01/24 13:54:50 The tag 2542-01.A1-02 changes the quality from Good to Disconnected

2013/01/24 13:54:59 The tag 2542-0 1, AI-01 changes the quality from Good to Disconnectzd

2018/01/24 13:54:50 The tag 2542-01.A1-00 changes the quality from Good to Disconnected

2018/01/24 13:54:59 The tag 2542-01.D10-11 changes the quality from Good to Disconnected

2018/01/24 13:54:50 The tag 2542-01.D10-10 changes the quality from Good to Disconnected

an‘m.rm 14 13:54:59 The tan 2547-01.010-04 channes the auality from Goad tn Nisronnected 2
“ [ £
Ready Time: 13:57:15
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10. The pink and gray flashing light indicates that the logger is performing the data supplement process.

Ees

Eile Server Logger Tools Runtime Help

TER BEBRNSKRGCOSHSS

= - Server Group Recording
‘ Server1{192.168.127.200:53192) |

sart | [..Step.

[] automatically start recording when service stari
Tag Selection
=& Logger Group List | v| |
Bﬁ LoggerGroupl Available Tags
*" Loggerl
Tag Name

1

11. After the data supplement process is complete, the light will change to red. The event log will show how long
the data supplement process took to perform, and the result of the supplement process.

i MX-AOPC UA
il Server Logger Tools Runtime Help )
9 E = = = == ar 3 T
TR PERODERKRn 008888
=5 ' Server Group FEcTEa E
Server1(192.168.127.200:53192) _
. s Cm) |
[] Automatically start recording when service starts running
Tag Selection
=8 Logger Group List ‘ - | | - | E| £
= a LoggerGroupl Available Tags Selected Tags
4G Loggerl —
Tag Mame [ » | Tag Name
>
=8 B
(«]
Server Name  Tag Name Description B
Serverl  2542-01.A100 Desc @
Serverl  2542-0LA101 Desc
Serverl  2542-01.A1-02 Desc
Serverl T 2542-01.A1-03 Desc - .
Date Time Event -
[ 2018/01/24 13:59:44 Dats supplement (Auto) end.
2018/01f24 13:59:44 Finished retrieving log [from 2018/01/24 05:54:58 to 2018/01,/24 05:58:41] from the device [MAC:00-90-e8-5a-21-6e].
2018/01f24 13:59:42 Retrieving log 11 [from 2018/01/24 05:54:58 to 2018/01/24 05:58:41] from the device [MAC:00-30-e8-55-21-6¢]
2018/01f24 13:59:42 Connecting to the device [MAC:00-90-e8-5a-21-6¢] for retrieving log from 2018/01/24 05: 54:58 to 2018/01/24 05:58:41...
2018/01724 13:58:44 Trying to connect to the device,
2018/01f24 13:58:44 Data supplement (Auto) begin.
2018/01f24 13:52:02 Data supplement (Auto) end.
2018/01f24 13:52:02 Finished retrieving log [from 2018/01/24 05:02:33 to 2018/01,/24 05:50:58] from the device [MAC:00-90-e8-5a-21-6€].
2018/01f24 13:52:00 Retrieving log 11 [from 2018/01/24 05:02:33 to 2018/01/24 05:50:58] from the device [MAC:00-90-e8-55-21-6e] =
;nl_n,._ 252 A A o s a T R T | o L TR R S i e SRS e .
Service Status : Running Time: 14:00:04 Data Supplement Queue: 0000

12. Open the database folder and note which files the supplementary data has been saved to.

. v Computer » Windows7_05 (C:) » Users » Public » Documents » Moxa » MXAOPCLogger » DataComplement » 00-90-e8-5a-21-6e

Organize « Open ~ Share with + Print Mew folder

-

o Favorites MName Date modified Type Size
‘E_-:_| Recent Places 2018-01-24-04-50-08_2018-01-24-05-52-08.csv 2018/1/24 F5 01:...  Microsoft Excel C... 58 KB
8 Downloads 2018-01-24-04-50-08_2018-01-24-05-59-48.csv 2018/1/24 F5 01:..  Microsoft Excel C... 66 KB
3 Dropbox | 2018-01-24-04-50-08_2018-01-24-06-45-58.c5v 2018/1/24 T 0. Microsoft Excel C.. 109 KB
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Testing the Data Supplement on Demand

Function

Take the following steps to test the data on demand function.

1. Ensure the logger is in recording mode.

File Server Logger Tools Runtime Help

cenEEBNSRECOSESS |

- - Server Group Eeerug =
.- [ Server1{192.168.127.200:53192) _
o)
[] Automatically start recording when service starts running
Tag Selection
=8 Logger Group List | '| | '| [G|
=g S Available Tags Selected Tags
Tag Mame | » | Tag Name
| »
ER
(«]
Server Mame  Tag Name Description =
Serverl Ty 2542-0LA100 Desc E
Serverl g 2542-0LA101 Desc 3
Serverl g 2542-01A102 Desc
Serverl T 2542-01A103 Desc -

2. Click the Stop Recording button to stop recording data, and then wait.

ME-AOPC UA

File Server Logger Tools Runtime

Help

TEERBEBRNIRH0C0SES S

=k . Server Group

- [ Server1(192.168.127.200:53192)

= E:I Logger Group List
EIE; LoggerGroup 1

ﬁ- Loggerl
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Getting Started

Click Logger Group List and then click the Data Supplement on Demand button. The default
on-demand period is one day in the past.

£ MX-AOPC UA Logger == =

QO & &s

File  Server Logger JTools Runtime Help

GLENY Y CY T

=1 ' Server Group
- [ Server1(192.168.127.200:53192)

StartDate:  1/23/2018 Start Tme (UTC):  7:36:35 AM ] %;%Eﬁ%-’ﬁ

| EndDate:  1/24/2018 = End Time (UTC): ~ 7:35:35 AM @ Refrieve Close

Log Folder:  C:\sers\Public\Documents Moxa MXAOPCLogger\Logger_on_Demand E
Timeout: 30 sec(s); Retries: 3 tme(s)

Start Date Start Time End Time

Date Time: Event
2018/01/24 15:34:31 Stop recording logg

< m

Service Status : Running Time: 15:36:51 Data Supplement Queue: 0000

Click the Retrieve button to start retrieving lost data in the defined period. The pink and gray flashing light
indicates that the logger is performing the data supplement process.

£ MX-AOPC UA Logger [=][@] = ]

COsdsd

File Server Logger Tools Runtime Help

s eEREOERG

= ‘ Server Group
5 Server1(192.168.127.200:53192)

- —
e T

StrtDate:  1/23/2018 ~  S@rtTme(UTC):  7ii4:s1AM [ %;%EFSEOTD")?LE

EndDate:  1/24/2018 EndTime (UTC):  7:1%:51aM [ | Rebieve Close

Log Folder:  C:Wsers\Public\Documents\Moxa \MXAOPCLoggerLogger_on_Demand E]
" Timeout: 30 sec(s); Retries: 3 time(s)

Start Date Start Time End Date End Time Result
| 2018/01/23 07:14:51 2018/01/24 07:14:51 Retrieving

il
I
Wil Date Time &
Wl 2018/01/24 15:17:35 £
Wl 2013/01/24 15:17:18
2013/01f24 15:17:03 20130124_005331\ ogger1_201801
2013/01/24 15:17:02 - £20180124_005331\Logger1_201801
2018/01f24 15:17:01 Retrieving log 13 [from 2018/01/23 07:14:51 to 2018/01f24 04:27:37] from the device [MAC:00-00-e8-5a-21-6e]
2018/01f24 15:17:01 LoggerGroup 1.Logger 1: supplement data is saved to C:\Users\Public\Documents\Moxa MXAOPCLogger\Logger\Logger 1_20180124_005331\Logger1_201801
2018/01f24 15:17:01 Connecting to the device [MAC:00-90-e8-5a-21-6¢] for retrieving log from 2018/01/23 07:14:51 to 2018/01/24 04:27:37...
2018/01f24 15:17:01 Trying to connect to the device,
2018/01f24 15:17:01 Data supplement (Demand) begin. =
;Tnmm T T i E— 3
Service Status : Running Time: 15:17:36 Data Supplement Queue: 0000
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5. Once the retrieving process is finished, the Result column will show Complete.

StartDate: 1/23/2018 »  StartTime (UTC):  7:18:17AM |2 EE‘;;EIEE”;EU?{U,E'C?‘;_D

End Date: 1/24/2018 = EndTime (UTC):  7:18:17AM || | Retieve || Close |
Log Folder:  C:'sers\Public\DocumentsiMoxaMXACPCLogger\Logger_on_Demand [ ]
Timeout: 30 sec(s); Retries: 3 time(s)
Start Date Start Time End Date End Time Result
2018/01/23 07:14:51 2018/01/24 07:14:51 Complete

6. To check detailed information, see the Log View at the bottom of the screen.

File Server Logger Tools Runtime Help

T EERNUKG

CO8s 8848 :

B ‘ Server Group !
E 5 Server1{192,168.127.200:53192)
=8 Logger Group List
=+ LoggerGroupl
4@ Loggert
Date Time Event =
2018/01/24 15:18:07 Data supplement (Demand) end.
2018/01/24 15:18:06 Finished retrieving log [from 2018/01/24 06:45:59 to 2018/01/24 07: 14:50] from the device [MAC:00-90-e8-5a-21-6e]. =|
2018/01f24 15:18:05 LoggerGroup 1.Logger 1: supplement data is saved to C:Ysers\Public\Documents\Moxa MXACOPCLogger\Logger Logger 120180124 005331 oggerl_ 201801
2018/01f24 15:17:53 Retrieving log 1/1 [from 2018/01/24 06:45:59 to 2018/01/24 07: 14:50] from the device [MAC:00-30-e8-5a-21-6e]
2018f01f24 15:17:52 Connecting to the device [MAC:00-30-e5-5a-21-6€] for retrieving log from 2018/01/24 06:45:52 to 2018/01/24 07: 14:50...
2018f01f24 15:17:52 Mo data found [from 20180123 07:14:51 to 2018/01/24 04:27:37] from the device [MAC:00-90-e8-55-21-6e] for supplement,
2018/01f24 15:17:35 Retrieving log 3/3 [from 2018/01/23 07:14:51 to 2018/01/24 04:27:37] from the device [MAC:00-30-e8-55-21-6&]
20180124 15:17:18 Retrieving log 2/3 [from 2018/01/23 07:14:51 to 2018/01/24 04:27:37] from the device [MAC:00-20-e8-55-21-6&]
2018/01f24 15:17:03 LoggerGroup 1.Logger 1: supplement data is saved to C:\Users\PubliciDocumentsMoxa MY AOPCLogger\LoggerLogger1_20180124 005331\ oggerl_201801
2018/01/24 15:17:02 LoggerGroup 1.Logger 1: supplement data is saved to C:Users\Public\DocumentsMoxa MY AOPCLogger Logger Loggerl_ 20180124 005331\ oggeri_2015801
2018/01f24 15:17:01 Retrieving log 1/3 [from 2018/01/23 07:14:51 to 2018/01/24 04:27:37] from the device [MAC:00-80-e58-53-21-6e]
2018/01f24 15:17:01 LoggerGroup 1.Logger 1: supplement data is saved to C:Users\Public\DocumentsMoxa MY AOPCLogger Logger YLoggerl_ 20180124 005331 oggeri_2015801
2018/01f24 15:17:01 Connecting to the device [MAC:00-30-e5-5a-21-6€] for retrieving log from 2018/01/23 07:14:51 to 2018/01/24 04:27:37...
2018/01f24 15:17:01 Trying to connect to the device.
2018/01f24 15:17:01 Data supplement (Demand) begin. E
P — i B 3
Service Status : Running Time: 15:19:34 Data Supplement Queue: 0000
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Testing the Data Supplement on Schedule
Function

Take the following steps to test the data on demand function.

1. Ensure that the runtime service is NOT in run mode.

File Server Logger Tools Runtime Help

P
e D e e

TER BERPNERa oOEgss

= - Server Group
I‘ B Server1(192. 168.127.200:53192)

2. Click Tools > Data Supplement Settings.

,

_Eile Server Logger IIonIs Buntime Help

1 = = &= Data Supplement Settings ! :

Certificate Management

= Server Grou
||I ‘ i Systern Log k
b u Server1(1¢

Change Password

Options

= i:j Logger Group List
(=~ LoggerGroupl
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3. Enable the Data supplement on schedule function, set the time (UTC Time) to a few minutes later and
data loss in the past to 1 day.

ouasppener e

7
[ General Settings
Retry Timeout 30 sec(s) (5 to 600, default: 300
Retries 3 {0 to 10, default: 3)
Triggering Event

Data supplement after network reconnection
Data supplement on schedule

Everyday at  18:15 S (UTC time)

Data loss in the past 1 day(s) (1 to 7, default: 1)

Data supplement through Cellular Data Access

IP Address c .0 .0 .0

Port |9400 (0 to 65535, default: 9400)

Folder for supplementary data

Path C:\Users\Public\Documents\Moxa MY ADPCL E]

Log Folder for Data Supplement on Demand

C:\Users\Public\Documents Moxa MY ACPCL O

o J[ concel |

4. Start the run time service.

s = 5

File Server Logger Tools Runtime Help

TR BEBNIKG[Closagss

B . Server Group
5 Server 1{192. 168.127.200:53192)

Recording

[ sart || swp |

Automatically start recording when service starts running
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5. Start recording the logger.

I __Eile Server I__ogger__ Tools Runtime Help )
‘Tl g A&

CEENSES& G 00
= ' Server Group

3 Server1{192. 158. 127, 200:53192)

AT o = =

[] automatically start recording when service starts running

Tag Selection
| 7] | -] e
Available Tags Selec
‘ Tag Mame | L | Tag
f=nisn]

6. When the specified time elapses, the data supplement on schedule function will be triggered. The progress
will be displayed in the Log View as shown below.

.__Eile Server Lugger_ Tools Runtime Help

ITES EERPNERG0C08SHSS
- Jgi Server Group Recording —

ke 5 Server1{192.168.127.200:53192) |T|

[ Automatically start recording when service starts running

»

Tag Selection
=~ Looger Group List | v| | > ‘ | G| £
(=& LoggerGroupl Available Tags S;d:ed Tags
.G [P S
q Tag Mame | » | Tag Name

Server Name  Tag Name Description

Serverl % 2542-01.A1-00 Desc
Serverl % 2542-0LA1-01 Desc
Serverl W 2542-01.A1-02 Desc
Serveri W 2542-01.A1-03 Desc

Date Time Event
—

2018/01/28 18:22:03 Data supplement (Schedule) end.

2018/01/28 18:22:03 Finished retrieving log [from 2018/01/28 10:19:54 to 2018/01/28 10:20:53] from the device [MAC:00-90-e8-55-21-6¢].
2018/01/28 18:22:00 Retrieving log 1/1 [from 2018/01/28 10:19:54 to 2018/01/28 10:20:59] from the device [MAC:00-90-e8-5a3-21-6e]
2018/01f28 18:22:00 Connecting to the device [MAC:00-90-e8-5a-21-6e] for retrieving log from 2015/01/28 10:19:54 to 2018/01/28 10:20:55...
2018/01/28 18:21:37 Finished retrieving log [from 2018/01/27 10:21:00 to 2018/01/28 10:16:40] from the device [MAC:00-20-e8-53-21-6].
2018/01/28 18:21:36 LoggerGroup 1.Logger 1: supplement data is saved to C:\Users\Public\DocumentsMoxa\MX ACPCLogger\Logger\Logger 1_20180124_005331\Logger
2018/01/28 18:21:30 Retrieving log 1/1 [from 2018/01,/27 10:21:00 to 2018/01,28 10:16:40] from the device [MAC:00-90-28-5a-21-6¢]
2018/01/28 18:21:29 Connecting to the device [MAC:00-90-e8-5a-21-6e] for retrieving log from 2018/01/27 10:21:00 to 2018/01/28 10:16:40...
2018/01/28 18:21:29 Trying to connect to the device.

2018/01/28 18:21:29 Data supplement {Schedule) begin.

2018/01/28 18:20:33 Start recording all logger

< T

Service Status : Running Time: 18:22:27 Data Supplement Queue: 0000
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Configuration Console

The following topics are covered in this chapter:

O Main Screen Overview
O Menu Items
» File
Server
Logger
Tools

Runtime

YV V VYV VY V

Help
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Main Screen Overview

The MX-AOPC UA Logger’s configuration console displays settings for connected MX-AOPC UA Servers and
loggers. It also shows the logger runtime status.

File Server Logger Tools Runtime Help 2
OFRABEBRONSKRG 008888

=23 ﬁ Server Group Recording =
l - ﬁ Server1(192. 168. 127, 200:53192)
Start Stop
4 || Automatically start recording when service starts running
Tag Selection
-8 Logger Group List [Sewerl v] |iAll Device '] =
E‘i] LoggerGroupl Available Tags Selected Tags
L 1
= Tag Name = | » Tag Name =
L DeviceGroupl.Devicel.TagGroupl.Tal—l E] %% 2542-01,A1-00 |i|
T E2242-01.A1-00 E T 2542-01.A1-01
W E2242-01.A1-01 W 2547.01.A1-02 4
i E2242-0L.AI-02 - E T 2542-01.A1-03
N I T i 2542-01,010-00 -
5
Server Mame  Tag Mame Description i
Serverl ¥ 2542-01.A1-00 Desc [l
Serverl W 2542-01.A1-01 Desc
Serverl ¥y 2542-01.A1-02 Desc
Serverl W 2542-01.A1-03 Desc -
Date Time Event
20180123 16:47:47 MX-ACPC UA Logger runtime service is stop.
2018/01f28 16:33:13 Auta reconnect to Server1 success! (Service)
2018/01/26 23:14:33 Initializing database...
2018/01f25 23:14:33 LoggerGroup1.Logger1is invalid. No tag is selected.
2018/01f26 23:14:30 MX-AQPC UA Logger runtime service is running. 7
4| m 2
Service Status : Stopped 8 Time164931 9 Data Supplement Queue: 0000 10
No. |Zone Description
1 Software Title Displays the name of the software: MX-AOPC UA Logger
2 Menu Bar All configuration functions can be accessed from these menu items
3 Quick Launch Bar Frequently used icons
4 Server View All MX-AOPC UA Servers
5 Logger View All Loggers
6 Detailed View Detailed settings of the servers and loggers
7 Log View Logger Runtime logs
8 Runtime Service Status Indicates if the logger runtime service is Running or Stopped
9 Logger Time Displays the Logger time (same as the PC’s time)
10 Data Supplement Queue Displays the data supplement waiting items in the queue
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Menu ltems

File

Use the File menu to manage project files.

24 MX-AOPC UA Logger - D:kfﬂﬂemk_cheniﬂm:malm_
[Eile] Server Logger Tools Runtime Help

Mew Ctrl+M ;! ﬁ
Open.. Ctrl+0 i

T

Save Ctrl+5

Save As,.,

1 AOPC_Loggers.aog
2 A0OPC_Loggerd.acg
3 AOPC_Logger3.aoqg
4 AOPC_Logger2.aog
5 AOPC_Loggerl.acg

Exit

= New: Create a new project file.

= Open: Open an existing project file.

= Save: Save the current project.

= Save As: Save the current project file as another project with a different filename.
= Previous saved files: Quickly open previously saved project files.

= Exit: Close the Configuration Console.
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Server

Use the Server menu to edit MX-AOPC UA Server connection settings.

£ wxa0vc U Logg A

File [Sewer] Logger Tools Runtime Help

- Discovery % ﬁ EE_} é_j a; ll:
] Connect i : -
& Disconnect

Delete 112:53192)

Properties

= §:i' Logger Group List

= Discovery: Discover MX-AOPC UA Servers and configure its connection settings.
= Connect: Connect the selected server.

= Disconnect: Disconnect the selected server.

= Delete: Delete the selected server.

= Properties: Modify the settings of the selected server.

NOTE

The properties of a server cannot be modified either when the server is in connecting mode, or runtime service
is in running mode. Stop runtime service and disconnect the server connection before modifying the server

properties.
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Logger

Use the Logger menu to edit logger settings.

-
i MX-AQPC UA Logger

File Server [Lﬂgger] Tools Runtime Help

Mew Logger Group

e

Mew Logger
Delete

Start Recording
Stop Recording

Data Supplement on Demand

Terrninate Data Supplement

Properties

= New Logger Group: Create a new logger group.

< New Logger: Create a new logger.

= Delete: Delete the selected logger.

= Start Recording: Start recording for a selected logger group or a selected logger.

= Stop Recording: Stop recording for a selected logger group or a selected logger.

= Data Supplement on Demand: Retrieve lost data during a specified period. Refer to Testing Data
Supplement on Demand in Chapter 2.

= Terminate Data Supplement: Terminate all of the data supplement waiting items in the queue.

= Properties: Modify the settings of an existing logger.

NOTE The properties of a logger cannot be modified either when the logger is in recording mode, or runtime service
is in running mode. Stop runtime service before modifying logger properties.
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Tools

Use the Tools menu to configure data supplement settings, for certificate management, to access a system log,
to change a password, or to modify console environment settings.

£ wxcAoPc Ua Loso=

File Server Logger | Tools | Runtime Help

s E— e Data Supplement Settings ! @

LHE B

8- ﬁ Server Group

Certificate Management

Systern Log [
Change Password

Options

=™ =8| cgger Group List
B

= Data Supplement Settings

ot o e S

I General Settings
Retry Timeout 30 sec(s) (5 to 600, default: 300
Retries 3 {0 to 10, default: 3)
Triggering Event

Data supplement after network reconnection
[ | pata supplement on schedule

Everyday at 00:00

Data loss in the past 1 day(s) (1 to 7, default: 1)

[] Data supplement through Cellular Data Access

IP Address c .0 .0 .0

Port | 5400 | (0 to 65535, defauit: 3400)
Folder for supplementary data

Path C:\Users\Public\Documents\Moxa MXACPCL: E]

Log Folder for Data Supplement on Demand

E:‘l.l_Jsers\Fublic\DnmmentsanaWADPCLI- 1

| ok || cancl
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» General Settings:

= Retry Timeout: The retry timeout interval for retrieving supplementary data from a device’s
buffer.

- Retries: The number of retries allowed after a retry timeout.

» Triggering Event: Enable the following functions if the Moxa products connected to an MX-AOPC UA
Server supports the data supplement function.

= Data supplement after network reconnection: Enable data supplement function after network
reconnection.

- Data supplement on schedule: Enable data supplement function on schedule at the specified
time. The triggering time can be set to everyday at a specific time. The data loss period can be set
to 1 to 7 days in the past.

» Data supplement through Cellular Data Access: Enable this function if the Moxa products
connected to the Cellular Data Access software support the data supplement function.

. IP Address: The IP address of the Cellular Data Access software.
- Port: The listen port of the Cellular Data Access software.

» Folder for supplementary data

= Path: The folder path to which the system can temporarily save supplementary data. Click Iil

|

to change the folder path. Click l—l to open the folder. Delete the supplementary data files
after the data is written to the database.

» Log Folder for Data Supplementary on Demand

- Path: The folder path to which the system can temporarily save the log files of the supplementary

data on demand. Click lil to change the folder path.
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Configuration Console

Certificate Management

If the security policy of the MX-AOPC UA Server is set to Basic128Rsal5: Sign, Basic128Rsal5: Sign
and Encrypt, or both, importing an OPC UA client’'s CA (Certificate Authority) file into the MX-AOPC UA
Server, and exporting the MX-AOPC UA Server’s CA file to OPC UA Clients are both required.

Click the Trust Servers tab, click Import, and select the server’s CA file to import it into the MX-AOPC UA
Logger. Click Export to export the selected certificate. Click Remove to remove the selected certificate.
Click Trust to trust the selected certificate. Click View Certificate to view the selected certificate.

Trust Servers | Instance Certiﬁmtes|

Server Mame

v MX-AQPC LA Server

LRI

urn: CHARLESCHEM-ME:MxX-AQPC LA Server

1L

Remove

Trust

| view Certificate. ..




MX-AOPC UA Logger Configuration Console

Click the Instance Certificates tab and click Export Logger Certificate to export the MX-AOPC UA
Logger’s CA file to OPC UA Server.

Cenicate: Menogerer ——
Trust Servers | Instance Certificates |

| View Logger Certificate. .. | Certificate MX-AQPC UA Logger is from
1/9/2018 4:24:45 PM to 12/14/2022
4:24:45 PM

[ Export Logger Certificate... ]

[ Reissue Certificate ]

NOTE After reissuing certificates or re-installing the MX-AOPC UA Logger, you will need to export the Logger
Certificate to the OPC UA Server again.

= System Log

1 WixA0PC U Loos

File Server Logger | Tools | Runtime Help

f— @ e Data Supplement Settings ] a @ 6 ii E
e - Certificate Management ; :
|
& Server Grou
ﬁ g System Log ] Save to Text File

Change Password Reset System fog

Options !
= & e |

» Save to Text File: Save the MX-AOPC UA Logger’s system log to a text file. You will be required to enter

System Log Settings

a password (default password = moxa).

Verify Password . u

Please enter password;:

| o J[ concel ]|
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» Reset System Log: Reset the MX-AOPC UA Logger’s system log. You will be required to enter a
password (default password = moxa).

MX-AOPC UA Logger (I [ ]

Verify Password u
. Do you want to reset system log? —
$ Y . g Pleaze enter password:

| Y || Mo [

K J [ Cancel

» System Log Settings: Defines the maximum number of records that can be saved in the MX-AOPC UA
Logger’s system log (values can range from 1 to 30000; the default value is 30000).

System Log Settings - u

Event Records: 30000

(1~30000)

| ok || cancel |

Change Password: Change the MX-AOPC UA Logger’s system password. The password is required when
updating configurations to System Runtime, saving system logs to a text file, or resetting the system log
(length: 4 to 128; acceptable characters: A to Z, a to z, O to 9, Symbols; default: moxa).

COld Password:

Mew Password:

Confirm Password;

[ ok || cancel |

Options: Configure environment settings for the MX-AOPC UA Logger’s configuration console.

v

Configuration File

Automatically save configuration every 10 min(s) (1 to 30, default: 10)

Automatically save configuration before exiting this console

[ Ok, ] [ Cancel

NOTE If Automatically save configuration every xx min(s) is enabled, the configuration file will be automatically

saved only when a filename is defined. Be sure to save your configuration file after creating a new project file.
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Runtime

Use the Runtime menu to Start, Stop, or Reinitialize Server Runtime Service.

i MX-AOPC UA Logger I

File Server Logger Tools Iﬂunﬁme Help

- _. e ‘ ﬁ Start Runtime Service ﬂ

B Stop Runtime Service

& ﬂ Server Group Reinitialize Runtime Service
------- ﬁ Server1(192, 168, 12 TTZ53197) |

Help

Use the Help menu to launch the Logger’s help documentation, to check the Logger’s license status, to add a
license file, or to check the logger version.

T E——

File Server Logger Tools Runtime

—_— —- e ﬁ E ﬁ LﬂggerHeIp

Licensing

- ﬁ Server Group About...
------- B server1(192.168.12.112:53192) I

Ctart
= Logger Help: Launch the MX-AOPC UA Logger’s help documentation.

« Licensing

T S —————

File Server Logger Tools Runtime!

r— —. - ﬁ ﬂ j LoggerHeIp Ny =

Licensing r License Info

= a Server Group About... Add License File
------- B Server1(192.168.12.112:53192) ‘ |

Deactivate License

Start

» License Info: Displays the Logger’s User Code, License Status, and the Time Remaining on the license.
Refer to License Registration and Activation to learn how to activate the license.

e e

User Code: 464EB14358CD

License Status: Free Version
The max. number of Server; 1

The max. number of Logger: 1
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» Add License File: Import a license file after completing the license registration process. Refer to
License Registration and Activation to learn how to activate the license.

» Deactivate License: Deactivate the current paid license version and load factory default settings. Note
that when you deactivate the license, your license file and runtime configurations will be deleted. Be
sure to back up your runtime configurations before executing a license deactivation procedure.

= About: Displays the MX-AOPC UA Logger’s version number and build number.

-
Moxa MX-AQPC LA Logger 1.0 build 16040818
|

gfj Copyright (C) 2016 Maxa Inc.
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Server Management

The following topics are covered in this chapter:

O Server Discovery
» Getting the Server Endpoint from an MX-AOPC UA Server
» Discovering MX-AOPC UA Servers
O Server Connection
» Connecting to the discovered MX-AOPC UA Server
» Editing the connection settings of the discovered MX-AOPC UA Server
» Deleting the connection settings of the discovered MX-AOPC UA Server
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Server Discovery

In this section we explain how to discover an MX-AOPC UA Server.

An MX-AOPC UA Logger can discover MX-AOPC UA Servers installed on a local or remote computer. First, get
the server endpoint, and then follow the onscreen instructions to discover the server. After the server has been

discovered, be sure to connect to the server before adding the tags into loggers for recording.

NOTE

The server discovery or server connection settings can only be configured when runtime service status Q
is stopped. To stop the runtime, click the stop runtime icon on the quick launch bar.

Getting the Server Endpoint from an MX-AOPC UA Server

1. Open the MX-AOPC UA Server configuration console by clicking Tools > OPC UA Settings > Server

Endpoint Settings. Be sure the status of the Server Endpoint is valid, and then copy the Server Endpoint of
the MX-AOPC UA Server.

Server Endpoints Settings H_E-J

URL Status
opc. top: /192, 168, 12, 112:53192MXACPC UAServer Valid

Metwork Interface: | Intel(R) Ethernet Connection (3) I215-1M bt

Port Mumber: 53192

opc.top: /192, 168. 12, 112: 53192/MXAQPC UASErver

[ Add I I Delete | | Apply I [ Close

Go to Tools - OPC UA Settings - Security Policy Setting and confirm the MX-AOPC UA Server’s security
policy settings. The security policy is applied to connections between OPC UA clients and the MX-AOPC UA
Server. If Basic128Rsal5: Sign, Basic128Rsal5: Sign and Encrypt, or both of these options are selected, you
will need to configure Certificates Management settings on both MX-AOPC UA Server (Tools 2 OPC UA
Settings = Certificates Management) and MX-AOPC UA Logger (Tools = Certificate Management). If
only “None” is selected, you only need to know the password of the MX-AOPC UA Server.

Security Policy Setting [ S|

MNone
[ Basic128R=a15 - Sign

i___i Basic128R:=a 15 - Sign and Encrypt

Ok ] [ Cancel
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Discovering MX-AOPC UA Servers

1. Go to the MX-AOPC UA Logger, right click a Server Group and then click Discovery in the pop up menu, or
click the Server Group to select it and then click the Discovery icon on the quick launch toolbar to start
discovering MX-AOPC UA Servers.

, N

Eile Server Logger Tools Runtime Help

ERESSRG008S

2. Select Local Server if the MX-AOPC UA Server and MX-AOPC UA Logger are installed on the same computer,
or click Remote Server Endpoint and type in the target Server Endpoint. Next, type in the password of the
MX-AOPC UA Server, and then click the Next button.

vcnrysner | ==

@ Local Server

| ope. tep://192. 168. 12. 112:53192/MXAOPC/UAServer -

") Remaote Server Endpoint

Password L Ll

| <Back || Next> | [ cancel
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3. Modify Server Name, and configure Security Policy and Security Mode to be the same as the MX-AOPC
UA Server’s UA Settings. If necessary, update the Publish Interval, Sampling Interval, Queue Size, or
Discard Oldest settings, and then click Finish.

Discovery Server LX)

Server Mame  Serverl {max. length = 30; ™. is not allowed)

Server Endpoint:  opc.top: /192, 168. 12, 112: 53192 MXAOQPC fUASErvEr

Security Policy [Nnne - ]

Security Mode INnne - I

Subscription Settings

Publich Interval O = ms (0 to 85400000, default: 1000)
Keep Alive Count 10
Lifetime Count 1000
Maonitored Item Settings

Sampling Interval 500 : me (-1 to 86400000, default: 500)

Queue Size 10 (0 to 10000, default: 10)

Discard Oldest  [¥/]

< Back H Finish ][ Cancel

» Server Name: Give a name for the connection of the MX-AOPC UA Server (max. length = 30; a period
“.” is not allowed). The server name should be unique and cannot be modified after you click Finish.

Server Endpoint: The server endpoint of the discovered MX-AOPC UA Server.
Security Policy: Configure the same security policy as the MX-AOPC UA Server.
Security Mode: Configure the same security mode as the MX-AOPC UA Server.

YV V V V

Subscription Settings: Configure the subscription settings for MX-AOPC UA Logger to receive OPC tag

data from the MX-AOPC UA Server.

- Publish Interval: The publish interval defines the rate at which the Server sends OPC tag data to
the Logger (unit: ms; values: O to 86400000; default: 1000; O: the fastest practical rate).

= Keep Alive Count: The keep alive count defines the number of publish intervals that must expire
before a keep alive message is sent to MX-AOPC UA Server.

- Lifetime Count: The lifetime count defines the number of times of publish interval can expire
without the MX-AOPC UA Logger sending data updates or keep alive messages before the server
deletes the subscription.

» Monitored Item Settings

= Sampling Interval: The sampling interval defines the rate at which the server checks for changes
in the monitored device readings (unit: ms; values: -1 to 86400000; default: 500; the default
interval set by the server: -1; the fastest practical rate: 0).

- Queue Size: The queue size defines the number of data updates that the OPC UA Server will queue
for the subscription
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= Discard Oldest: The discard oldest defines the discard policy of the queue. When checked, the
oldest notification in the queue will be discarded and will not be sent to the MX-AOPC UA Logger.
When unchecked, the latest notification will be discarded and will not be sent to the MX-AOPC UA
Logger (default setting: enabled).

Server Connection

In this section we explain how to connect to the discovered MX-AOPC UA Server, and how to modify the
connection settings.

Connecting to the discovered MX-AOPC UA Server

Before configuring the logger, you must first connect to the discovered MX-AOPC UA Server to get the OPC tag
list from the servers.

Ensure the runtime service is stop.

2. Right click the server and click Connect in the pop up menu, or click the server to select it and then click
the Connect icon on the quick launch toolbar. The server should now be connected to the MX-AOPC UA
Logger.

O )
File Server Logger Tools Runtime Help

r e
Tal BoAl

ERONSKG 008884
- [ Server Group

‘ Server1(192.168.127.200:53192)

Server Endpoint: opc. top: (192, 168,127, 200: 53192/MXACPC UAServer

Connect
Disconnect Security Policy: Mone
Delete Security Mode:  MNone
=~ B4 Logger Group List P X
B--E LoggerGroupl R Subscription Settings Monitored Item Settings
- ﬁ- Logger1
Publish Interval: 1000 ms Sampling Interval: 500 ms
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes
Date Time Event
4 | - . :
Service Status: Stopped b Tirne: 18:38:41 Data Supplement Queue: 0000
= — =
& MX-AOPC UA Logger _

ICTE R BEBPNIERE0088 88

=5 B Server Group ‘ ‘

ﬁ Serveri(192.168.127.200:53192)

Server Endpoint:  opc.top: /{192,168, 127, 200: 53192 MXAOPC /UAServer

Security Policy: MNone

4-5
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Editing the connection settings of the discovered MX-AOPC UA

Server

Take the following steps to edit the connection settings of the discovered MX-AOPC UA Server:

1. Ensure the runtime service is stopped.
2. Rightclick the server and click Disconnect in the pop up menu, or click the server to select it and then click
the Disconnect icon on the quick launch toolbar.

v e s

Eile Server Logger Tools Runtime Help
@

—— _ —_— ) 3 > . - 3 4
TR ABPEEBNERK G 0088 48
= B Server Group
B -'E'"Eflﬁg" 168.127.200:33137) Server Endpoint:  opc. top: /192, 168, 127, 200:53192/MXAOPC/UAServer

Connect
e Security Policy: Mone
Delete Security Mode: Maone
L Gi List 5
8 H i i Properties
EE LoggerGroupl Subscription Settings Monitored Item Settings
-4 Logger1
Publish Interval: 1000 ms Sampling Interval: 500 ms
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes

Date Time Event

2018/01f28 18:45:40 Connect to Server1 success!

| 1 b

Service Status : Stopped Time: 18:48:44 Data Supplement Queue: 0000

3. Right click the server and click Properties in the pop up menu, or click the server to select it and then click
the Properties icon on the quick launch toolbar. Follow the onscreen instructions to edit the settings.

(o re B, )

Eile Server Logger JTools Runtime Help

SEET Y L I S EICCEEIEE

—

B Server Group
5 Server1(192. 168, 127.200:53192)

Server Endpoint: opc. tcp: /{192, 168. 127. 200: 53192/MXAOPC/UAServer

Connect

2 Security Policy: Maone
Disconnect
Delete Security Mode: Mone

=~ Logger Group List
(- LoggerGroupl fizpetie Subscription Settings Monitored Item Settings
:..4g) Logger1
Publish Interval: 1000 ms Sampling Interval: 500 ms

NOTE The server name cannot be modified after the initial setting. To change the server name, delete the original
server settings and then use the server discovery process to create a new one. Note that deleting the server
connection settings will delete all of the related logger settings at the same time.
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Deleting the connection settings of the discovered MX-AOPC

UA Server

Take the following steps to delete the connection settings of the discovered MX-AOPC UA Server:

1. Ensure the runtime service is stopped.

2. Right click the server and click Delete in the popup menu, or click the server to select it and then click the
Delete icon on the quick launch toolbar.

Ei!e §e_wel Logger I_oo!s _Eumime ﬁ_elp

iNEHEBEBNS

&9 O

(OREREIEERE

= ' Server Group

¥ ~Yserver1(192.168.127.200:53192)

Server Endpoint:

opc. top: f{192, 168, 127, 200: 53192 /MXAOPC/UAServer

Connect

e connect Security Policy: Mone

Delete Security Mode: Mone
B~ i Logger Group List z X

=k a LoggerGroupl mpslie ubscription Settings Monitored Item Settings
e Logger1
Publish Interval: 1000 ms Sampling Interval: 500 ms
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest: Yes
Date Time Event
<[ m 3
Service Status : Stopped Time: 18:52:13

Data Supplement Queue: 0000

3. Click OK to confirm that you would like to delete logger settings at the same time.

wesorc s osse ==

Deleting this server endpoint will delete all of the related logger settings at the
same time. Do you want to delete this server endpoint?

| ok || Cancel
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Logger Management

The following topics are covered in this chapter:

O Logger Group
» Adding a Logger Group to a Logger Group List
» Editing a Logger Group
» Deleting a Logger Group
O Loggers
» Adding a Logger to a Tag Group
» Editing a Logger
» Deleting a Logger
O Logger Recording
» Select Tags for Recording
» Start or Stop Recording
» Logger Status



MX-AOPC UA Logger Logger Management

Logger Group

In this section we explain how to use the configuration console to add, edit, and delete logger groups.

Adding a Logger Group to a Logger Group List

Ensure that the runtime service is stopped.
2. Right click the Logger Group List and then click New Logger Group in the popup menu, or click the Logger
Group List to select it and then click the New Tag Group icon on the Quick Launch toolbar.
(507 U i e
File Server Logger Tools Runtime Help
TR BEBAUgKG 008888
Bn Server Group
‘ Server1(192. 168.127. 200:53192)

Mew Logger Group

Start Recording

Stop Recording

Date Time Event
< [ T F
Ser\rice Status : Stopped | Time: 18:55:07 Data Supplement Queus: 0000
3. Type in the name of the logger group (max. length = 30 characters; “.” is not allowed) and then click OK.

Logger Group Pmpiriy- |

Logger Group MName LoggerGroupl

{max. length = 30; ."is not allowed)

o | [ concel |
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4. The new logger group will be added to the Logger Group List.

 File Server Logger Tools Runtime Help

L ‘“|ﬂ§5€l$&@\@@££@§

B ' Server Group Logger Name Output
‘ Server1(192.168.127.200:53192)

(=83 H Logger Group List
<) oggerGroupl

Editing a Logger Group

Right click the logger group and then click Properties in the popup menu, or click the logger group to select
it and then click the Properties icon on the Quick Launch toolbar.

B MX-AOPC UA Lo

.FllE Server Logger Tools Runtime Help

O m ﬂ\ssuaam@\@fﬁa@\@g

' Server Group Logger Name
[ Server1(192.168.127.200:53152)

E|[:I Logger Group List

New Logger
Delete

Start Recording
Stop Recording

Properﬁﬁ

Deleting a Logger Group

Right click the logger group and then click Delete in the popup menu, or click the logger group to select it and
then click the Delete icon on the Quick Launch toolbar.

g MX-AOPC UA Logge

Eile Server Logger Tools Runtime Help

;l‘““ﬁh@ﬂﬁﬁi.ﬁ&[ﬁlﬁﬁﬁﬁ\ag

=5 - Server Group Logger Mame Type Output
------- ‘ Server1{192.168,127,200:53192)

= [:f Logger Group List

Mew Logger
Delete

Start Recording
Stop Recording

Properties

5-3
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Loggers

In this section we explain how to use the configuration console to add, edit, and delete loggers.

Adding a Logger to a Tag Group

Ensure the runtime service is stopped.

2. Right click on the logger group that the logger will be added to and then click New Logger in the popup
menu, or click the logger group to select it and then click the New Logger icon on the Quick Launch toolbar.

|—-——-|
File Server Logger Tools Runtime Help

rFABEERAEK 008888

=38 ‘ Server Group Logger Name Type Output
s Server1{192, 168,127.200:53192)

E|§;I Logger Group List

New Logger
Delete

Start Recording
Stop Recording

Properties
Date Time Event
< . v
Service Status : Stopped Time: 10:00:27 Data Supplement Queue: 0000
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3. Type in the name of the logger, configure the data file type, database or Azure 10T, and then click Next.

Logger Settings Iﬁ

Logger Mame L 000 e

(max. length = 30; only 20 if using Crade Database)

(@) Excel File:
Root Path: C:\UsersPublic\Documents Moxa \MXAQPCLogger \Logger [I]
File separated every min. (default; 60)
) Access File:
Root Path: C:\UsersPublic\Documents Moxa \MXACQPCLogger \Logger
i7) Database:

LN
m

Source Mame:

]

) Azure IoT:

Connection String:

« Back Mext = ] [ Cancel I

» Logger Name: The naming rules of the logger name depend on the specifications of Microsoft Excel,
Access, SQL Server, Oracle Database, or Azure 10T. The naming rules can be summarized as follows:
- Microsoft Excel (max. length = 30; the first four characters: a-z, A-z; the following characters: 0-9,
a-z, A-Z, )
- Microsoft Access (max. length = 30; the following characters are NOT allowed: . ! ~ []"'),)
. Database Source Name (DSN) and Azure 1oT (max. length = 30 (only 20 if using Oracle Database);
the following characters are NOT allowed: . []',”)
» Excel File: Select this option if you would like to record data into Excel files. Configure the root path for
saving those files. Configure the time if you would like to separate the files by interval.
» Access File: Select this option if you would like to record data into Access files. Configure the root path
for saving those files.
» Database: Select this option if you would like to record data into a Microsoft SQL Server or Oracle
database. Refer to Appendix B for details on how to configure the database connection settings.
» Azure I0T: Select this option if you would like to record data in a Microsoft Azure 10T Cloud. Copy the
Connection String you got from Microsoft Azure and paste it into this field.
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4. Select the Data Field items, change the default names in the Table Field, change the order of the items, and

if necessary change the time format for the timestamp. Click Finish to save the settings.

Logger Settings Iﬁ
Data Field *Table Field Data Type F
<TAG_ID> <TAG_ID> String E
<WALUE= <VALLE= Siring
<UNIT > <UNIT=> String
<SOURCE_UTC_TIMESTA... <50URCE_UTC_TIMESTA... *DateTime
<SOURCE_TIMEZOME = <SOURCE_TIMEZOME = Float

] <DATA_TYPE:
[[] <SERVER_UTC_TIMESTA...
[C] <SERVER_TIMEZONE:>
[ <QUALITY>
*max. length =30; " #£[]{}"'?., ""are not allowed
** pption: DateTime or String
[] Automatically start recording when service starts running.
< Back ][ Finish ] [ Cancel I

» Data Field: By default, data of <TAG_ID>, <VALUE>, <UNIT>, <SOURCE_UTC_TIMESTAMP=>,
<SOURCE_TIMEZONE=> will be recorded into the database. Data of <DATA_TYPE>,

<SERVER_UTC_TIMESTAMP>, <SERVER_TIMEZONE=>, and <QUALITY> are optional. The time data of
<SOURCE_UTC_TIMESTAMP=> and <SOURCE_TIMEZONE=> in an OPC tag is added by Moxa’s 1/0 device
when the event occurs. The time data of <SERVER_UTC_TIMESTAMP> and <SERVER_TIMEZONE=> in
an OPC tag is added by the MX-AOPC UA Server when the tag is received.

Table Field: The name of each data field, which can be defined by the user, will be the column name of
the table in the database. The max. length is 30 characters.

The following characters are not allowed: ' # $[1{}"'?., .

Data Type: The data type of the timestamp can be either DateTime or String type. If the second value
of the timestamp has decimal points, select String type to record the decimal point value into the
database. The DateTime format only supports integer values.

E: Move the selected item up.

E: Move the selected item down.

Automatically start recording when service starts running: Enable this function if you want the
logger to start recording automatically whenever the runtime service starts running.
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Editing a Logger

Take the following steps to edit a logger’s properties:

Ensure the runtime service is stopped.

2. Right click the logger and then click Properties in the popup menu, or click the logger to select it and then
click the Properties icon on the Quick Launch toolbar.

£ MX-AOPC UA Logger

(File Server Logger Tools Ru

BEEITII LY

&7 008858

=5 ‘ Server Group

----- [ server1(192.168.127.200:53192)

Recording
st | [ swp |

[ Automatically start recording when service starts running
Tag Selection

= E Loager Group List
(- LoggerGroupl

Delete

Start Recording
Stop Recording

Properties

[serverz ~| [llDevice -] [c]

Available Tags Selected Tags

Tag Name Tag Mame

i 2542-01.A1-00
Ty 2542-01.A1-01
Wy 2542-01.A1-02
iy 2542-01.A1-03 -

) —T—

KEFF

m

Server Name  Tag Name Description

Date Time Event

< [ m

Service Status : Stopped Tirne: 19:08:49

Data Supplement Queue: 0000
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Deleting a Logger

Take the following steps to delete a logger:

1. Ensure the runtime service is stopped.

2. Right click the logger and click Delete in the popup menu, or click the logger to select it and then click the
Delete icon on the quick launch toolbar.

File Server I___u

TJools Runtime Help

(T )

e

EEENT 1 L PRI

=8 ' Server Group
foo. [ Server1(192. 168.127.200:53192)

Recording
[ st ][ swp |

Automatically start recording when service starts running

»

Tag Selection
= E Logger Group List [Se'uerl V] I.ﬂ Device VI @
Eﬁ} Lo?gerGrcupl Available Tags Selected Tags
-
Delete Tag Mame D » Tag Mame
& 2542-01.A1-00 E
Start Recording W 2542-01.A101 E
Stop Recording i‘g 2542-01.A1-02 E
W 2542-01.A1-03 -
Properties < ([T} r
Server Mame  Tag MName Description
Date Time Event
e LU}
Service Status : Stopped Time: 19:14:26 Data Supplement Queue: 0000

3. Click OK to confirm that you would like to delete this logger.

MX-AOPC UA Luggel 31

Do you really want to delete this logger?

Ok

Cancel ]
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Logger Recording

In this section we explain how to use the configuration console to select tags for recording, to start or stop

recording, and to check the status of a logger.

Select Tags for Recording

1. Ensure the runtime service is stopped.

Ensure that the server is connected.

Click the refresh button to get the updated tags from the server.

(i om0 I ek

File Server Logger Tools Runtime Help

ITEABEBRNEKET 0088 8S

»

= U Server Group

[E Server1(192.168.127.200:53192) |

Recording

[ st |[ swp |

|| Automatically start recording when service starts running

=] H Logger Group List
-5 LoggerGroupl
e @ Loggerl

Tag Selection
[Serverl '] [AJI Device '][@ !
elected Tags

Available Tags

Tag Mame o .8 Tag Name

¥ 2542-01.A1-00 E]
i 2542-01.A1-01 E
W 2542-01.A1-02
W 2542-01.A1-03 - E
4 1 3

Server Name  Tag MName Description

Date Time

Event

4

mn

Service Status : Stopped

Time: 191559

Data Supplement Queue: 0000
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4. Select the tag in the Available Tags list and click the arrow button to add it into the Selected Tags list.

Tag Selection

[Seruerl v] [All Device v]

Available Tags Selected Tags

Tag Mame Tag Mame

L " DAC-D1.AT-00

T DAC-01.AI-01
Ty DAC-01.AI-02
% DAC-01.AI03 -
i 1 3 i | Il P

T

Server Mame  Tag Mame Description

> E]: add all tags into the Selected Tags list.
> E: add a selected tag into the Selected Tags list.
> E: remove a selected tag from the Selected Tags list.

> E: removed all tags from the Selected Tags list.

5. The data from the tags in the list shown below will be recorded after the logger is in recording mode.

Tag Selection
Serverl v] [All Device v]
Available Tags Selected Tags
Tag Mame E > ; Taag Mame =
E] ¥ DAC-0L.AI-00 L4
E] % DAC-01.AI-01
% DAC-OL.AI0Z2
E] W DAC-01.AI-03 -
< | i | + [ m | [atd

Server Mame  Tag Mame Description

Serverl ¥y DAC-01.AI-00

Serverl ¥ DAC-0LAIO1
Serverl %y DAC-D1.AI-02
Serverl T DAC-01.AI-03
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Start or Stop Recording

P w N R

Ensure the runtime service is running.
Ensure the server is connected.
Ensure the logger is in ready mode (indicated by green lights).

To start recording all loggers in one logger group, right click on the logger group and then click Start
Recording in the popup menu, or click the logger group to select it and then click the Start Recording icon
on the Quick Launch toolbar.

R T

File Server Logger Tools Runtime Help

@ ﬂ\ﬂﬁeﬁsw@@ﬂ\rﬁﬁ

=8 , Server Group Logger Name Output
Server1(192.168,127.200: 53:‘32}—' Logger 1 Excel C:\Users\Public\DocumentsMoxa MXAOPCLogger Y oggerLogger 1_20180125_110...

=} 53 Logger Group List
[=¢

MNew Logger
Delete

Start Recording
Stop Recording

Properties
Date Time Event
2018/01/28 19:17:58 LoggerGroup 1.Logger 1 sucessfully connected to database!
2018/01/28 19:17:58 Initislizing database. ..
2018/01/28 1%:17:54 MX-AOQPC UA Logger runtime service is running.
< ] r
Service Status : Running Time: 19:18:06 Data Supplement Queue: 0000

All of the loggers in the logger group will be in recording mode (indicated by red lights).

Eile Server Logger Tocols PRuntime Help

{0 = “\ﬁﬂﬁﬂ@@@\@@@@@@

(= - Server Group Logger Mame Output
------- 5 Server1(192, 168,127, 200:53192) Loggerl Excel C:Wsers\Public\DocumentsMoxa M

= E Logger Group List
LogaerGroup1
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6. To start recording a specific logger, right click on the logger and then click Start Recording in the popup
menu, or click the logger to select it and then click the Start Recording icon on the Quick Launch toolbar.

o e S

File  Server Lngger Jools Runtime Help

i ® 5| BB BOEKE00EE s s

=R ' Server Group

' Recording
' Server1(192. 168.127.200:53192) [

sart. | | Stp |

[] Automatically start recording when service starts running

Tag Selection
=~ H Logger Group List | = | | | E
BE} LoggerGroupl Available Tags Sel
Tag Mame T

Delete

Start Recording
Stop Recording

4ol |,

Properties

7. To stop recording, right click on the logger group or the logger and then click Stop Recording in the popup
menu, or click the logger group or the logger to select it and then click the Stop Recording icon on the
Quick Launch toolbar.

'
oo I

File Server Logger Tools Runtime Help

CEABBBDYR T 00

= - Server Group Logger Mame
' Server1(192.168.127.200:53192) Loggerl Excel C:\.Users‘PubIlc\Dnmments\Mo

lS

=8 Logger Group List
B~

=81 oagerGroup]

“ Logger1 MNew Logger
Delete

Start Recording
Stop Recording

Properties
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8. To check the recorded data, stop the runtime service and click the data folder of the logger. Open the data

file in the folder to check the recorded data.

File Server Logger Tools Runtime Help
ITEH BEBRNIKHT 0088 8S

=P ﬁ Server Group
oo [ Server1(192.168.127.200:53192)

3

Recording —
Start Stop

[ Automatically start recording when service starts running

Tag Selection
=& Logger Group List [Sewerl - I [NI Device - ]
- i] LoggerGroupl Available Tags Selected Tags
..4g) Logger1

Tag Name | » Tag Name = L
& DeviceGroup L.Device 1. TagGroup 17al E] W 2542-01.A1-00 E 1
i E2242-01.AL-00 E W 2542-01.A101
W E2242-01.A1-01 W 2542-01.A1-02
i E2242-01.A1-02 - E W 2542-0L.A1-03
] L 3 W 2542-01.010-00 -
Server Mame  Tag Mame Description i
Serverl W 2542-0LAI-00 Desc (o
Serverl S 2542-01.A1-01 Desc -
Serverl W 2542-01L.A1-02 Desc
Serverl W 2542-01.A1-03 Desc =

Property

Type: Excel

23 T
Output: C:V..lsers\PubIic\DocumemsWoanAOPCLoggerV_ogger\Logger1_20180128_1].084(:

Table: Loggeri

Date Time Event

2018/01f28 19:25:20 MX-A0PC UA Logger runtime service is stop.

2018/01/28 19:23:38 Start recording logger group 'LoggerGroup'

4 | i r
Service Status : Stopped Time: 19:25:49 Data Supplement Queue: 0000

¢ Computer » Windows7_05(C:) » Users » Public » Documents

Organize = Include in library = Share with = Mew folder
W Favorites Ridme
"= Recent Places @ Loggerl_20180128_110000.xs

4. Downloads

NOTE Be sure to close the Excel or Access file at the target root path before starting to record. Otherwise, the
MX-AOPC UA Logger will not be able to record data to the target file.
NOTE DO NOT open the spreadsheet when recording. Doing so will cause the file to be corrupted because it is already

opened by the MX-AOPC UA Logger service. To open the spreadsheet, stop the runtime service of the MX-AOPC
UA Logger, and then click the folder icon to access the file.
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Logger Status

The following table gives the meanings of the logger status indicator lights.

Light

Color

Status

Note

Solid Gray

Configurable Mode

The logger can be configured only when
runtime service stops.

Any configuration change will be updated to the
Logger’s runtime service after starting the
runtime service. Without starting the runtime
service, any change will be discarded after the
configuration console is closed. Be sure to save
your project file when you close the
configuration console.

Solid Green

Ready Mode

The logger is ready for recording.

Solid Red

Recording Mode

The logger is recording.

Solid Yellow

Error Mode — Configuration

The logger is not configured correctly, and data
is not being saved to the database.

Check the tag selection or database connection
of the logger.

A server related to some selected tags is

© © © 00 ¢

Flashing Red disconnected.
Error Mode — Server .
and Yellow Check the server connection or server’s
Endpoint settings.
" . . The logger is retrieving supplementary data
Flashing Pink . .
Data Supplement Mode from device’s buffer storage or supplementing
and Gray

data into the database.
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License Registration and Activation

Three versions of the MX-AOPC UA Logger are available. The trial version, which supports up to 1 MX-AOPC UA
Server connection and up to 1 data logger, can be installed and used for 30 days without registration. To use

the free and paid versions you must submit a license registration. Both free and paid versions can be used
indefinitely, but the free version only supports up to 1 MX-AOPC UA Server connection and up to 1 data logger.
The three versions are summarized in the following table:

Version MX-AOPC UA Server connection Data Logger Run Time License File
Trial Upto1l Upto1l 30 days Not Required
Free Upto1l Upto1l Unlimited Required
Paid Up to 2 Up to 10 Unlimited Required

Take the following steps to register a license.

Step 1:

Get the PC User Code from the MX-AOPC UA Logger’s configuration console by clicking Help - License. For

the paid version, you will need to purchase a registration code from your Moxa distributor. The Registration

Code can be found on the product label.

License Info
il

e S|

User Code: 464EB14358CD
License Status: Free Version
The max, number of Server; 1

The max. number of Logger: 1

MOXA®

MIN:

Product S/N: I‘L!I!!\L![!M"IIII
0.0

Rev: 1.

Made in Taiwan
PIN: 3093015000021

Registration Code: | I || [HIHHHI

TZADO10000001231
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Step 2:
Go to Moxa’s Software Licensing website (http://license.moxa.com) and log in with your Moxa account and

password, or apply for an account if this is your first visit to the site.

Step 3:

On the Software Licensing website, navigate to Activate Your Software - Software Package > MX-AOPC
UA Logger. Select Free Version and enter the User Code, or select Paid Version and enter both the User
Code and Registration Code.

MOX/\  Software Licensing

Home = Activate Your Software = Software Package = ME-ADPC UA Logger

Free Version
User Code: | |

= Paid Version

Registration Code: | |
User Code: | |

Step 4:
Download the license file to a folder on your PC and unzip it.

Step 5:
From the MX-AOPC UA Logger’s configuration console, click Help - Licensing - Add License File to add the
license file (.lic) to the MX-AOPC UA Logger.

& MX-AOPC UA Loge
File Server Logger Tools Runtlme I_

- _ - ‘ ﬁ ﬁ j Legger Help ' '

il Licensing k License Info

= ﬁ Server Group About... Add License File
------- w Server1(192.168.12.112:5319 ‘ | Deactivate License
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Step 6:
After license activation is complete, go to Help - License Info to check the current license status.

; Your license has been activated. The new license will take effect after

runtime service restarts,

OK

e =
i—i
User Code: 464EB14358CD

License Status: Free Version
The max. number of Server; 1

The max. number of Logger: 1
e

|
I
User Code: 464EB14358CD

License Status: Paid Version
The max. number of Server; 2

The max. number of Logger: 10
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System Performance Reference

These performance results provide a reference for evaluating MX-AOPC UA Logger’s capability when designing
a system architecture. The results show the maximum number of tags of data that can be recorded into the

database without resulting in a data queue.

CPU: i7-4790, 3.60 GHz

RAM: 8 GB

Operating System: Microsoft Windows 7

Editor: Microsoft Office 2010 Access and Excel

Database: Oracle database, Microsoft SQL Server, MySQL
OPC UA Software: MX-AOPC UA Server & MX-AOPC UA Logger
Cloud: Azure loT

Test Case:

» One database at a time

» Disabled data supplement function

» Only running real-time data recording function

Database Type Sl Max. No. of Tags Max. No. of Tags
(per 1 second) (per 5 seconds)

File Excel 2000 10000

File Access 3000 15000

DSN Excel 2000 10000

DSN Access 3000 15000

DSN Microsoft SQL 1300 6500

DSN Oracle 2000 10000

DSN MySQL 800 4000

Cloud Azure loT 30 150
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Database Connection Settings

In this chapter, we explain how to connect a Logger to a Microsoft SQL Server or Oracle database.

1. Open ODBC Data Source Administrator by typing “odbcad32.exe” in the Windows Start search field, and
then click it.

Programs (1)
& odbcad32.exe

p' See more results

|. odbcad32.exd _ | Hibernate J_b|

B Documents | l 'ysﬂ\ﬁ"ﬁd 9
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2. Click the System DNS tab and then click Add.

I "

- ODBC Data Source Administrator @

| User DSN | System DSN | File DSM | Drivers | Tracing | Connection Pooling | About |

System Data Sources:

Mame Driver Add...

An ODBC System data source stores information about how to connect to
D; the indicated data provider. A System data source is visible to all users
= an this machine, including NT services.

0K || Cancsl Aoply Help

=

3. Select ODBC driver for Oracle if you are using an Oracle database, and select ODBC Driver xx for SQL
Server if you are using a Microsoft SQL Server. In the example shown below, “ODBC Driver 11 for SQL
Server” is selected. Click Finish to go to the next step.

I )

Create Mew Data Source @

Select a driver for which you want to set up a data source.

Mame V-
Microsoft Texd Driver "bd; *.csv) &
Microsoft Test-Treiber (*bd; *.cav) G
Microsoft YVisual FoxPro Driver 1
Microsoft Visual FoxPro-Treiber 1
QDBC Driver 11 for SQAL Server 23 |
S0L Server g|E |
S0QL Server MNative Client 11.0 P
1 | 1 a ¥
< Back Finish ] [ Cancel

NOTE MX-AOPC UA Logger supports Oracle database (x86) and Microsoft SQL Server (x86) connections.
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4. Type a name for the data source in the Name field. Click the Server field down arrow to search for

instances of SQL Server. Select your target SQL Server, and then click Finish.

I

Create a Mew Data Source to 5L Server

=

y-

SOL Server

This wizard will help you create an ODBC data source that you can use to connect to
S0L Server.
What name do you want to use to refer to the data source?

MName: MSSGL

How do you wart to describe the data source?

Description:

Which SQL Server do you want to connect to?

=)

Tl | E 1TV INWSOLEXPRESS -

Fish || Net> | | Cancel | | Hel

-

5. Click Test Data Source to test the connection, or click OK to proceed.

I

ODBC Microseft SQL Server Setup ==

-

Anew ODBC data source will be created with the following configuration:

Microgsoft ODBC Driver for SQL Server Version 12.00.2000 »

Data Source Name: MS5GL

Data Source Description:

Server: IETTWINTWSQLEXPRESS

Use Integrated Securty: Yes

Database: (Default)

Language: (Default)

Data Encryption: Mo

Trust Server Cerificate: Mo

Multiple Active Result Sets{(MARS): No
Translate Character Data: Yes

Log Long Running Queries: No

Log Driver Statistics: Mo

Ilse Regional Settings: Mo

Ize AMSI Quoted |dentifiers: Yes

IUse AMSI Mull, Paddings and Wamings: Yes
Server Service Principle Mame(SPN):
Mimor Server Service Principle Name{SPM):

Test Data Source... ] [ QK J [ Cancel
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6. Click OK to complete ODBC Data Source settings.

I "

5_! QDBC Data Source Administrator

| User DSN | System DSN | File DSM | Drivers | Tracing | Connection Pooling | About |

System Data Sources:

Mame  Driver Ad

|\xElS ODBC Driver 11 for SQL Server T T—

Corfigure. ..

11

An ODBC System data source stores information about how to connect to
m; the indicated data provider. A System data source is visible to all users
= an this machine, including NT services.

| ok || cancel Apply Help
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7. Open Microsoft SQL Server Manage Studio. Right click on Security & Logins 2 NT

AUTHORITY\SYSTEM, and then click Properties.

File

Edit

Object Explorer
Connect = * x*

View Debug Tools

- -2

¢

L"x: Microsoft SOL Server Management Studic (Adrministrator)
Window

#|J%NEWQ'JE’}' J% hlu‘-ﬁ::' eI 3

Help

» I X

(=
=

= @ CHARLESCHEN-MEB (SQL Server 12.0.5000.0 - HQIDC

Databases
Security
Lagins

ae TEMS_PolicyEventProcessinglogings
m 22MS_Policy TsqlExecutionLoging®

L NT AUTHORITY\SYSTEM

a NT Service\MSSQL!
aa NT SERVICE\SQLSE
aa NT SERVICE\SQLWI
aa NT SERVICEWWinm
e 53
Server Roles
Credentials
Cryptographic Provide
Audits
Server Audit Specificati
Server Objects
Replication
Always On High Availabilit
Management

Mew Login...

Script Login as 3

Policies 3

Facets

Start PowerShell

Reports 3

Rename

Delete

Refresh
Properties

Integration Services Catalogs
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8. Ensure the default database is master.

IT Script ~ @ Help

Login name: NT AUTHORITY\SYSTEN Search. | ||
@ Windows authentication

SQL Server authentication

& User Mapping
# Securables
F Status

Password: | |

Corfirm password: | |
Specify old password

Old password: | |

[] Erforce password palicy
[] Enforce password expiration

[] User must change password at nest login

Mapped to cedificate | - |
Connection Mapped to asymmetric key | . |
Map to Credential | v| | Add
Mapped Credentials Credential Provider
¥ Miew connection properties
Progress | Remove
Ready Default database: [master 'n
Default language: [E’:g&sh ']“

[ ok || Ccancel

B-6
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9. Ensure that Public for Server Roles is enabled.

IT Scipt ~ @ Hebp

rver Roles
User Mapping Server role is used to grant server-wide security privileges to a user.
# Securables
& Status
Server roles:
bulkadmin
dbcreator
dishadmin

serveradmin
setupadmin

¢¥ VMiew connection properties

Ready

[ ok ]| Ccancel
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10. Enable the Master Database of the User Mapping, and enable the db_owner and public roles of the

master.

F Status

¢¥ View connection properties

Ready

IT Script ~ @ Help

ra = v ™y
¥ oo amorer I ek

Users mapped to this login:

Uzer
NT AUTHORITY'\SYS...  dbo

Map Database

master
model
msdb
tempdb

Default Schema

[¥/] Guest account enabled for: master

Database role membership for: master

1 db_accessadmin

| db_backupoperator
| |[] db_datareader
\[[] db_datawriter
db_ddladmin

\ M | db_denydatareader
i |¥] db_denydatawriter
| db_owner

4/ | db_securtyadmin
V] public

J [ concs

B-8
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11. Select the Database option when setting the Logger’s data destination, and then click Setting.

Logger Mame Loggerl

(max. length = 30; anly 20 if using Orade Database)

() Excel File:
Root Path: C:\Wsers\Public\DocumentsiMoxa MXAOPCLogger Y ogger
Output Folder:  Loggerl 20180128 _110840
File separated every | &0 min. (default; 60)
i) Access File:
Root Path: C:\UsersPublic\Documents Moxa \MXACQPCLogger \Logger
Output Folder:
i@ Database:
Source Mame:
i) Azure IoT:

Connection String:

« Back L Mext = ] [ Cancel

12. Click the Machine Data Source tab, select the SQL Server data source, and then click OK.

Select Data Source Fﬂ
File Data Source | Machine Data Source
Data Source Name Type Description
dBASE Files |zer
Excel Files |zer
M5 Access Database |zer

Sysen

A Machine Data Source is specific to this machine, and cannot be shared.
"User" data sources are specific to a user on this machine. "System” data
sources can be used by all users on this machine, or by a system-wide service.

| oK || Cancel || Hep

NOTE DO NOT click NEW from this window to configure ODBC Data Source settings. You will not be able to
successfully connect the logger with the database.
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13. The data source name is displayed in the Source Name field. Click NEXT to continue the Logger Settings.
Refer to Chapter 5 for information about the following settings.

cogrsenrs: . ==

Logger Mame Loggerl

(max, length = 30; anly 20 if using Orade Database)

() Excel File:
Root Path: C:\Users‘Public\Documents Moxa \MXAQPCLogger \Logger | |
Output Folder:  Loggerl 20180123 _110840 -
File separated every |6|:| v| min. (default; 60)

i) Access File:
Root Path: |C: WWsers\Public\Documents Moxa MY AOPCLogger \Logger | | |
Output Folder:

i@ Database:
Source Mame: FSSOL Setting

i) Azure IoT:

Connection String: |

B-10
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